Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

⚠️ DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

⚠️ WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

⚠️ CAUTION
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

⚠️ CAUTION
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

NOTICE
indicates that an unintended result or situation can occur if the corresponding information is not taken into account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The device/system may only be set up and used in conjunction with this documentation. Commissioning and operation of a device/system may only be performed by qualified personnel. Within the context of the safety notes in this documentation qualified persons are defined as persons who are authorized to commission, ground and label devices, systems and circuits in accordance with established safety practices and standards.

Proper use of Siemens products

Note the following:

⚠️ WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be adhered to. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
# Table of contents

1 Preface ............................................................... ............................................................... 7

2 Use and Areas of Application ............................................................... ................... 11

2.1 Usage of SIMATIC PCS 7 BOX ...................................................................................................11
2.2 Using SIMATIC PCS 7 AS RTX ...................................................................................................15

3 Structure of SIMATIC PCS 7 BOX ............................................................................................... 17

3.1 Introduction .................................................................................................................................17
3.2 Hardware and software components of SIMATIC PCS 7 BOX ...................................................18
3.2.1 Hardware components of SIMATIC PCS 7 BOX .........................................................................18
3.2.2 Software components of SIMATIC PCS 7 BOX ..........................................................................20
3.2.3 Compatibility to SIMATIC PCS 7 .................................................................................................24
3.3 Configurations with SIMATIC PCS 7 BOX .....................................................................................25
3.3.1 Configuration options ...................................................................................................................25
3.3.2 SIMATIC PCS 7 BOX as a single-station system .........................................................................26
3.3.3 SIMATIC PCS 7 BOX with external engineering .........................................................................29
3.3.4 SIMATIC PCS 7 BOX in the PCS 7 network ...............................................................................32
3.4 Connection options for SIMATIC PCS 7 BOX ..............................................................................36
3.4.1 Connection to PROFIBUS DP .....................................................................................................36
3.4.2 Connection of intelligent field devices .........................................................................................38
3.4.3 Network connection to Industrial Ethernet ...................................................................................40
3.5 Operator panel of the CPU ..........................................................................................................41
3.5.1 Operator panel of the CPU ..........................................................................................................41

4 Commissioning and Configuring SIMATIC PCS 7 BOX ................................................................ 43

4.1 Introduction ..................................................................................................................................43
4.2 Requirements for loading the BOX PC ........................................................................................45
4.3 Configuring SIMATIC PCS 7 BOX for a single-station system ....................................................47
4.3.1 Overview of configuration tasks .................................................................................................47
4.3.2 How to create a new PCS 7 project .............................................................................................48
4.3.3 How to rename the SIMATIC PC station .......................................................................................49
4.3.4 How to edit the hardware configuration of the BOX PC ..............................................................50
4.3.5 How to set the access point on the BOX PC for SIMATIC PDM ....................................................51
4.3.6 How to check the setting of the access point for the PG/PC interface .........................................53
4.3.7 How to configure the SIMATIC PCS 7 BOX 416 .........................................................................54
4.3.8 How to configure the SIMATIC PCS 7 BOX RTX .......................................................................56
4.3.9 How to download the BOX PC ......................................................................................................58
4.3.10 How to configure the Automation License Manager for SIMATIC PCS 7 BOX 416 ....................59
4.3.11 How to open the operator panel of the CPU ...............................................................................60
4.3.12 How to compile and download the AS data and OS data ............................................................61
4.3.13 How to set the CPU in RUN ......................................................................................................63
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.4</td>
<td>Configuring SIMATIC PCS 7 BOX with external engineering</td>
<td>64</td>
</tr>
<tr>
<td>4.4.1</td>
<td>Overview of configuration tasks</td>
<td>64</td>
</tr>
<tr>
<td>4.4.2</td>
<td>How to select the communication module in SIMATIC Shell</td>
<td>65</td>
</tr>
<tr>
<td>4.4.3</td>
<td>How to create a new PCS 7 project</td>
<td>67</td>
</tr>
<tr>
<td>4.4.4</td>
<td>How to rename the SIMATIC PC station</td>
<td>69</td>
</tr>
<tr>
<td>4.4.5</td>
<td>How to expand your PCS 7 project to include an engineering station</td>
<td>70</td>
</tr>
<tr>
<td>4.4.6</td>
<td>How to edit the hardware configuration of the PC stations on the engineering station</td>
<td>71</td>
</tr>
<tr>
<td>4.4.7</td>
<td>How to set the access point on the BOX PC</td>
<td>72</td>
</tr>
<tr>
<td>4.4.8</td>
<td>How to configure NetPro on the external engineering station</td>
<td>74</td>
</tr>
<tr>
<td>4.4.9</td>
<td>How to configure the SIMATIC PCS 7 BOX 416</td>
<td>76</td>
</tr>
<tr>
<td>4.4.10</td>
<td>How to configure the SIMATIC PCS 7 BOX RTX</td>
<td>78</td>
</tr>
<tr>
<td>4.4.11</td>
<td>How to download the BOX PC</td>
<td>80</td>
</tr>
<tr>
<td>4.4.12</td>
<td>How to configure the Automation License Manager for SIMATIC PCS 7 BOX 416</td>
<td>82</td>
</tr>
<tr>
<td>4.4.13</td>
<td>How to open the operator panel of the CPU</td>
<td>83</td>
</tr>
<tr>
<td>4.4.14</td>
<td>How to compile and download the AS data and OS data on an external engineering station</td>
<td>84</td>
</tr>
<tr>
<td>4.4.15</td>
<td>How to set the CPU in RUN</td>
<td>86</td>
</tr>
<tr>
<td>4.5</td>
<td>Configuring SIMATIC PCS 7 BOX in the PCS 7 network</td>
<td>87</td>
</tr>
<tr>
<td>4.5.1</td>
<td>Overview of configuration tasks</td>
<td>87</td>
</tr>
<tr>
<td>4.5.2</td>
<td>How to select the communication module in SIMATIC Shell</td>
<td>89</td>
</tr>
<tr>
<td>4.5.3</td>
<td>How to expand your PCS 7 project to include a SIMATIC PCS 7 BOX station</td>
<td>91</td>
</tr>
<tr>
<td>4.5.4</td>
<td>How to rename the SIMATIC PC station</td>
<td>93</td>
</tr>
<tr>
<td>4.5.5</td>
<td>How to edit the hardware configuration of the PC stations on the engineering station</td>
<td>94</td>
</tr>
<tr>
<td>4.5.6</td>
<td>How to set the access point on the BOX PC</td>
<td>95</td>
</tr>
<tr>
<td>4.5.7</td>
<td>How to configure NetPro for SIMATIC PCS 7 BOX in the PCS 7 network</td>
<td>97</td>
</tr>
<tr>
<td>4.5.8</td>
<td>How to configure the SIMATIC PCS 7 BOX 416</td>
<td>99</td>
</tr>
<tr>
<td>4.5.9</td>
<td>How to configure the SIMATIC PCS 7 BOX RTX</td>
<td>101</td>
</tr>
<tr>
<td>4.5.10</td>
<td>How to download the BOX PC</td>
<td>103</td>
</tr>
<tr>
<td>4.5.11</td>
<td>How to configure the Automation License Manager for SIMATIC PCS 7 BOX 416</td>
<td>104</td>
</tr>
<tr>
<td>4.5.12</td>
<td>How to open the operator panel of the CPU</td>
<td>105</td>
</tr>
<tr>
<td>4.5.13</td>
<td>How to compile and download the AS data and OS data in the PCS 7 network</td>
<td>106</td>
</tr>
<tr>
<td>4.5.14</td>
<td>How to set the CPU in RUN</td>
<td>108</td>
</tr>
</tbody>
</table>

5 Installation of SIMATIC PCS 7 AS RTX | 109 |
| 5.1 | Introduction | 109 |
| 5.2 | Hardware and Software Components of SIMATIC PCS 7 AS RTX | 110 |
| 5.2.1 | Hardware Components of SIMATIC PCS 7 AS RTX | 110 |
| 5.2.2 | “SIMATIC”, "SIMATIC”.Software Components of SIMATIC PCS 7 AS RTX | 111 |
| 5.2.3 | Compatibility to SIMATIC PCS 7 | 112 |
| 5.3 | Connection Options for SIMATIC PCS 7 AS RTX | 114 |
| 5.3.1 | Network Connection to Industrial Ethernet | 114 |
| 5.3.2 | Connecting to PROFIBUS | 115 |
| 5.4 | Operator Panel of the CPU | 116 |
| 5.4.1 | Operator panel of the CPU | 116 |
# Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>6 Commissioning and Configuration of SIMATIC PCS 7 AS RTX</strong></td>
<td>117</td>
</tr>
<tr>
<td>6.1 Overview of configuration tasks</td>
<td>117</td>
</tr>
<tr>
<td>6.2 How to expand your PCS 7 project to include a SIMATIC PCS 7 AS RTX</td>
<td>118</td>
</tr>
<tr>
<td>6.3 Overview of Commissioning Tasks</td>
<td>120</td>
</tr>
<tr>
<td>6.4 Options for commissioning a SIMATIC PCS 7 AS RTX</td>
<td>121</td>
</tr>
<tr>
<td>6.5 How to change the network settings for a remote desktop connection on a PC</td>
<td>122</td>
</tr>
<tr>
<td>6.6 How to set up a remote desktop connection to SIMATIC PCS 7 AS RTX</td>
<td>124</td>
</tr>
<tr>
<td>6.7 How to Change the Computer Name for SIMATIC PCS 7 AS RTX</td>
<td>126</td>
</tr>
<tr>
<td>6.8 How to Set the Network Addresses of SIMATIC PCS 7 AS RTX</td>
<td>127</td>
</tr>
<tr>
<td>6.9 How to meet the requirements for reestablishing network connections</td>
<td>129</td>
</tr>
<tr>
<td>6.10 How to set the components on the SIMATIC PCS 7 AS RTX</td>
<td>130</td>
</tr>
<tr>
<td>6.11 How to configure and download a SIMATIC PCS 7 AS RTX</td>
<td>132</td>
</tr>
<tr>
<td>6.12 How to Transfer the License Keys</td>
<td>134</td>
</tr>
<tr>
<td>6.13 How to Open the Operator Panel of the CPU</td>
<td>136</td>
</tr>
<tr>
<td>6.14 How to activate the automatic start of the AS</td>
<td>137</td>
</tr>
<tr>
<td>6.15 How to compile and download the AS</td>
<td>139</td>
</tr>
<tr>
<td>6.16 How to use write protection (EWF) for the Compact Flash card (CF card)</td>
<td>141</td>
</tr>
<tr>
<td>6.17 Additional Information on Working with Remote Desktop Connections</td>
<td>142</td>
</tr>
<tr>
<td>6.17.1 How to Save the Connection Settings to a File</td>
<td>142</td>
</tr>
<tr>
<td>6.17.2 How to close a connection without stopping ongoing processes</td>
<td>143</td>
</tr>
<tr>
<td>6.17.3 How to Open a Saved Connection</td>
<td>143</td>
</tr>
<tr>
<td>6.17.4 How to Perform a Restart via a Remote Desktop Connection</td>
<td>144</td>
</tr>
<tr>
<td><strong>7 Establishing the factory state</strong></td>
<td>145</td>
</tr>
<tr>
<td>7.1 Establishing the factory state</td>
<td>145</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td>147</td>
</tr>
</tbody>
</table>
Preface

Purpose of this documentation

This documentation provides information about the components, areas of application, configuration options, and commissioning of the following PCS 7 introductory components:

- **SIMATIC PCS 7 BOX**
  SIMATIC PCS 7 BOX is an industrial PC, which comprises the functions of a PCS 7 process control system (engineering, automation, operator control and monitoring) when used in conjunction with a distributed I/O. The following versions are described here:
  - SIMATIC PCS 7 BOX 416: Version with Slot PLC CPU 416-2 PCI
  - SIMATIC PCS 7 BOX RTX: Version with software PLC WinLC RTX

- **SIMATIC PCS 7 AS RTX**
  SIMATIC PCS 7 AS RTX is an industrial PC, which provides the functionality of an automation system in PCS 7 together with the distributed I/O.

Required basic knowledge

This documentation is intended for personnel involved in configuring, commissioning, and servicing.

Basic knowledge of the general use of the PC/programming device and of the use of the Windows operating system is required. You should also be familiar with the functions and configurations of SIMATIC S7 (S7-400, STEP 7), SIMATIC NET and SIMATIC PCS 7.

Validity of the documentation

This documentation is valid for the software package *Process Control System; PCS 7 Toolset* as of V7.1.

Changes compared with the previous version

PCS 7 V7.1 or later

- You will find information about time synchronization in the *Process Control System PCS 7; PCS 7 Time Synchronization* function manual.

PCS 7 V7.0 SP1 or later
Below you will find an overview of the most important changes in the documentation compared with the previous version:

- **Application, configuration, and commissioning of SIMATIC PCS 7 BOX RTX**
  You can find information about this in the following sections:
  - Section "Usage of SIMATIC PCS 7 BOX (Page 11)"
  - Section "Structure of SIMATIC PCS 7 BOX (Page 17)"
  - Section "Commissioning and Configuring SIMATIC PCS 7 BOX (Page 43)"

- **Application, configuration, and commissioning of SIMATIC PCS 7 AS RTX**
  You can find information about this in the following sections:
  - Section "Using SIMATIC PCS 7 AS RTX (Page 15)"
  - Section "Installation of SIMATIC PCS 7 AS RTX (Page 109)"
  - Section "Commissioning and Configuration of SIMATIC PCS 7 AS RTX (Page 117)"

- The "High-precision time stamping" function can be used with SIMATIC PCS 7 BOX. You will find more information in the function manual *Process Control System PCS 7; High-precision Time Stamping.*

**Conventions**

In this documentation the designations of elements of the user interface are specified in the language of this documentation. If you have installed a multi-language package for the operating system, some of the designations will be displayed in the base language of the operating system after a language switch and will, therefore, differ from the designations used in the documentation.

Much of the information in this documentation applies to several components. To ensure that the products to which such information applies are clearly identifiable, we have used the following designations:

<table>
<thead>
<tr>
<th>Designation</th>
<th>Validity</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC PCS 7 BOX 416</td>
<td>The related information only applies to SIMATIC PCS 7 BOX 416.</td>
</tr>
<tr>
<td>SIMATIC PCS 7 BOX RTX</td>
<td>The related information only applies to SIMATIC PCS 7 BOX RTX.</td>
</tr>
<tr>
<td>SIMATIC PCS 7 BOX</td>
<td>The related information applies to SIMATIC PCS 7 BOX 416 and SIMATIC PCS 7 BOX RTX.</td>
</tr>
<tr>
<td>SIMATIC PCS 7 AS RTX</td>
<td>The related information only applies to SIMATIC PCS 7 AS RTX.</td>
</tr>
</tbody>
</table>

**PCS 7 glossary**

A PCS 7 glossary containing definitions of important specialist terms used in the documentation is available on the *SIMATIC PCS 7; Manual Collection DVD* or within the PCS 7 software via the help menu of the SIMATIC Manager (menu command Help > Help Topics > "Glossary" button).
Further Support

If you have any technical questions, please get in touch with your Siemens representative or responsible agent.

You will find your contact person at:

http://www.siemens.com/automation/partner

You will find a guide to the technical documentation offered for the individual SIMATIC Products and Systems at:

http://www.siemens.com/simatic-tech-doku-portal

The online catalog and order system is found under:

http://mall.automation.siemens.com/

Training Centers

Siemens offers a number of training courses to familiarize you with the Process Control System SIMATIC PCS 7. Please contact your regional training center or our central training center in D 90327 Nuremberg, Germany for details:

Telephone: +49 (911) 895-3200 *)

Internet: http://www.sitrain.com
Technical Support

You can reach the Technical Support for all Industry Automation and Drive Technology products

- **Via the Web formula for the Support Request**
  [http://www.siemens.com/automation/support-request](http://www.siemens.com/automation/support-request)
- **Phone:**  + 49 180 5050 222 *
- **Fax:**   + 49 180 5050 223 *

Additional information about our Technical Support can be found on the Internet pages
[http://www.siemens.com/automation/service](http://www.siemens.com/automation/service)

Service & Support on the Internet

In addition to our documentation, we offer our Know-how online on the internet at:
[http://www.siemens.com/automation/service&support](http://www.siemens.com/automation/service&support)

where you will find the following:

- The newsletter, which constantly provides you with up-to-date information on your products.
- The right documents via our Search function in Service & Support.
- A forum, where users and experts from all over the world exchange their experiences.
- Your local representative for Industry Automation and Drive Technology.
- Information on field service, repairs, spare parts and consulting.

*) Please note the following if you call the phone number listed: You may incur costs which vary from the standard costs for land lines. Calls from a cellular network may be more expensive.
2.1 Usage of SIMATIC PCS 7 BOX

What is SIMATIC PCS 7 BOX?

SIMATIC PCS 7 BOX is a complete process control system consisting of the following components:

- Operator station (OS)
- Automation System (AS)
- Optional: Engineering station (ES) (depending on the configuration variant)

With SIMATIC PCS 7 BOX enables you to economically realize a complete process control system with necessary components and the standard SIMATIC PCS 7 software.

In conjunction with a distributed I/O, the SIMATIC PCS 7 BOX offers an easy-to-use, complete process control system in terms of functionality and configuration technology, which can be commissioned quickly and easily. SIMATIC PCS 7 BOX is an economic and comprehensive hardware solution for automation systems. SIMATIC PCS 7 BOX is especially suitable as an introduction to process automation and for small process automation tasks.

You can place the SIMATIC PCS 7 BOX as a bundle PC at the actual location for the automation process, as it is designed for these environmental conditions.

Areas of application for SIMATIC PCS 7 Box

SIMATIC PCS 7 BOX can be used in the following application areas:

- Autonomous small plants
- Subprocess units (package units) with an integrated operator control and monitoring unit
- Testing, educational and training systems
- Research facilities

You can take advantage of all aspects of the modern SIMATIC PCS 7 process control system through complete integration in SIMATIC PCS 7. Above all, this applies to the following applications:

- When the engineering station is external from the SIMATIC PCS 7 BOX and the engineering is therefore performed on an external engineering station
- Establishing AS-AS communication using SIMATIC PCS 7 BOX in a PCS 7 network
- Combination of local operator control and monitoring function with SIMATIC PCS 7 BOX and central operator control and monitoring function with PCS 7 OS in the control room
- SIMATIC PCS 7 BOX RTX is an economic automation system for plants in which configuration in run (CiR) is not required.
## Overview of SIMATIC PCS 7 BOX versions

The following SIMATIC PCS 7 BOX versions are available for use in PCS 7:

<table>
<thead>
<tr>
<th>Variants</th>
<th>Description</th>
<th>Related sections in this manual</th>
</tr>
</thead>
</table>
| SIMATIC PCS 7 BOX 416 | The hardware it is based on is a Box PC. SIMATIC PCS 7 BOX 416 features an integrated CPU 416-2 in the form of a PCI card (Slot PLC CPU 416-2 PCI). You connect the distributed I/O to the PROFIBUS DP interfaces on the CPU 416-2 PCI. | • Structure of SIMATIC PCS 7 BOX (Page 17)  
• Commissioning and Configuring SIMATIC PCS 7 BOX (Page 43) |
| SIMATIC PCS 7 BOX RTX | The hardware it is based on is a Box PC. SIMATIC PCS 7 BOX RTX features Software PLC WinLC RTX. You connect the distributed I/O via the CP 5613 PROFIBUS DP interface. | • Structure of SIMATIC PCS 7 BOX (Page 17)  
• Commissioning and Configuring SIMATIC PCS 7 BOX (Page 43) |
Example configuration with SIMATIC PCS 7 BOX 416

In the figure below, the SIMATIC PCS 7 BOX 416 is shown as a single-station system with a connected distributed I/O.
Example configuration with SIMATIC PCS 7 BOX RTX
The following image depicts SIMATIC PCS 7 BOX RTX as a single station variant connected to distributed I/O.
2.2 Using SIMATIC PCS 7 AS RTX

What is SIMATIC PCS 7 AS RTX?
SIMATIC PCS 7 AS RTX is an automation system (AS) with the WinLC RTX software PLC on a MICROBOX PC.
With SIMATIC PCS 7 AS RTX you can economically realize an automation system for integration in a PCS 7 process control system.
When it comes to functionality and design, SIMATIC PCS 7 AS RTX together with distributed I/O provides a complete automation system for use in the lower-performance category.
You can locate SIMATIC PCS 7 AS RTX directly at the site of the automation process because has been designed for such environmental conditions.

Areas of application for SIMATIC PCS 7 AS RTX
SIMATIC PCS 7 AS RTX is suitable for the following areas of application:
• Test plants
• Small systems
• Plants in which configuration in run (CiR) is not required.

SIMATIC PCS 7 AS RTX variants
The following SIMATIC PCS 7 AS RTX variants are available for using in PCS 7:

<table>
<thead>
<tr>
<th>SIMATIC PCS 7 AS RTX</th>
<th>AS model</th>
<th>Related sections in this manual</th>
</tr>
</thead>
</table>
| SIMATIC PCS 7 AS RTX      | SIMATIC PCS 7 AS RTX provides a WinLC RTX software PLC. You connect the distributed I/O via the PROFIBUS DP CP 5611 interface integrated in the MICROBOX PC. | • Installation of SIMATIC PCS 7 AS RTX (Page 109)  
• Commissioning and Configuration of SIMATIC PCS 7 AS RTX (Page 117) |
Example configuration with SIMATIC PCS 7 AS RTX

In the following figure, SIMATIC PCS 7 AS RTX is shown in a network with an engineering station.
Structure of SIMATIC PCS 7 BOX

3.1 Introduction

Introduction

The following sections contain configuration options and general information about the structure of SIMATIC PCS 7 BOX.

The characteristics of the process control system corresponds to the SIMATIC PCS 7 standard. The characteristics of the CPU corresponds to the controller used.

Overview

The sections below describe topics related to hardware updates:

- Hardware and software components of SIMATIC PCS 7 BOX
- Configurations with SIMATIC PCS 7 BOX
- Connection options for SIMATIC PCS 7 BOX
- Operator panel of the CPU

Ordering information

The ST PCS 7 catalog contains ordering information for the following SIMATIC PCS 7 BOX PCs:

- SIMATIC PCS 7 BOX 416
- SIMATIC PCS 7 BOX RTX

Additional information

- Configuration manual Process Control System PCS 7; Engineering System
- Configuration manual Process Control System PCS 7; Operator Station
- Manual SIMATIC; Windows Automation Center RTX; WinAC RTX 2008
- Manual SIMATIC; WinAC Slot Version V4.0
- Manual SIMATIC; The Process Device Manager
- Manual SIMATIC; Automation License Manager
3.2 Hardware and software components of SIMATIC PCS 7 BOX

3.2.1 Hardware components of SIMATIC PCS 7 BOX

Introduction

SIMATIC PCS 7 BOX (SIMATIC PCS 7 BOX 416 and SIMATIC PCS 7 BOX RTX) are offered as a bundle with standard hardware.

Technical features of SIMATIC PCS 7 BOX PCs

You can find the technical features of the respective versions of the SIMATIC PCS 7 BOX PCs supplied in the ST PCS 7 catalog. This includes the following information:

- General features (processor, work memory/main memory, free expansion slots, graphics controller)
- Drives (hard disks, DVD)
- Interfaces (Ethernet, PROFIBUS DP, automation system (CPU) and serial ports, ports for mouse, keyboard, and printer)

The SIMATIC PCS 7 BOX PCs have 2 integrated Ethernet interfaces. These integrated Ethernet interfaces are preconfigured for the appropriate bus systems (terminal or plant bus). A description of which Ethernet interface is configured for which bus system is found in the product information supplied with the PCS 7 BOX PCs.

NOTICE

The following applies to SIMATIC PCS 7 BOX 416:

Even if SIMATIC PCS 7 BOX 416 is not connected to an Ethernet bus, at least one on-board Ethernet interface must be active. Any on-board Ethernet interface is used as the connection path to the integrated CPU for AS-AS communication.

The CPU can not be addressed via the on-board Ethernet interface in the following cases:

- The Ethernet interface is deactivated.
- The SIMATIC PCS 7 BOX PC is switched off.
- The SIMATIC PCS 7 BOX PC is in an unstable state.

The CPU 416 operating mode does not change when the PC is switched off, provided that the power supply for the CPU 416 is ensured. Additional information on the factory state is available in the section "Network connection to Industrial Ethernet (Page 40)."

Supplied accessories

A USB mouse is included in the bundle for SIMATIC PCS 7 BOX.
Optional expansion of the product bundle

You can expand the product bundle to include the following add-on components:

- Display and CRT monitors for office and industrial environments
- Keyboard (German or international keyboard layout)
- SITOP modular 20 A (power supply)
- SITOP DC UPS module
- SITOP battery module (for the CPU of SIMATIC PCS 7 BOX 416)

Additional information

- Product information SIMATIC PCS 7 BOX
- Catalog ST PCS 7, Chapter "ES/OS/BATCH/IT Basic Devices"
- Catalog PC-based Automation
- pcs7-readme.chm
3.2 Hardware and software components of SIMATIC PCS 7 BOX

3.2.2 Software components of SIMATIC PCS 7 BOX

Configuration variants (product bundles)

SIMATIC PCS 7 BOX 416 and SIMATIC PCS 7 BOX RTX are both offered as a product bundles in two preinstalled configuration variants.

- **Configuration variant 1:** SIMATIC PCS 7 complete system with AS, ES and OS functionality:
  - CPU as module or software version
  - Engineering station
  - OS single-station system

- **Configuration variant 2:** SIMATIC PCS 7 runtime system with AS and OS functions:
  - CPU as module or software version
  - OS single-station system

You configure the PCS 7 system with an external engineering station (not included in the product bundle).

Preinstalled software components on SIMATIC PCS 7 BOX

The following software components are preinstalled on SIMATIC PCS 7 BOX:

- **Software for the operating system:**
  - Windows XP Professional; Internet Explorer and MS SQL Server

- **Software components of SIMATIC PCS 7:**
  - Selected software component of the PCS 7 Toolset DVD
  - For SIMATIC PCS 7 BOX 416: SIMATIC WinAC CPU 41x-2PCI V4.0
  - For SIMATIC PCS 7 BOX RTX: SIMATIC WinAC RTX
License keys in the SIMATIC PCS 7 BOX product package

Note
A SIMATIC PCS 7 license grants the user permission to use the products. This permission is granted in the form of:
- CoL (Certificate of License) - a legal proof of the ownership of a copyrighted SIMATIC PCS 7 software product.
- License key (authorization code) - technical representation of the license.

Note
You can find information about the license keys required for an OS single-station system or an engineering station in the documentation Process Control System PCS 7; PC Configuration and Authorization.

The license keys in the standard SIMATIC PCS 7 BOX package limit the size of the configurable plants. You need several license keys for a SIMATIC PCS 7 BOX station:
- Configuration variant 1:

<table>
<thead>
<tr>
<th>Components requiring the license key</th>
<th>License keys for SIMATIC PCS 7 BOX 416</th>
<th>License keys for SIMATIC PCS 7 BOX RTX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software for the CPU</td>
<td>No license required</td>
<td>WinAC; WinAC RTX</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SIMATIC PCS 7; RTX</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SIMATIC NET; Industrial Ethernet SOFTNET S7 Basic</td>
</tr>
<tr>
<td>PCS 7 Engineering &amp; PCS 7 OS</td>
<td>WinCC RC PO (250)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(plant sizes up to 250 PO)</td>
<td></td>
</tr>
<tr>
<td>PCS 7 AS Runtime</td>
<td>AS RT PO (250)</td>
<td></td>
</tr>
</tbody>
</table>

- Configuration variant 2:

<table>
<thead>
<tr>
<th>Components requiring a license key</th>
<th>License keys for SIMATIC PCS 7 BOX 416</th>
<th>License keys for SIMATIC PCS 7 BOX RTX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software for the CPU</td>
<td>No license required</td>
<td>WinAC; WinAC RTX</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SIMATIC PCS 7; RTX</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SIMATIC NET; SIMATIC NET, Industrial Ethernet SOFTNET S7 Basic</td>
</tr>
<tr>
<td>PCS 7 OS</td>
<td>WinCC RT PO (250)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(plant sizes up to 250 PO)</td>
<td></td>
</tr>
<tr>
<td>PCS 7 AS Runtime</td>
<td>AS RT PO (250)</td>
<td></td>
</tr>
</tbody>
</table>
Activating the software components

Before you can use the software components, the valid license keys must be available on the SIMATIC PCS 7 BOX PC. The license keys are supplied on a license key diskette. You can transfer the license keys onto the SIMATIC PCS 7 BOX PC with the Automation License Manager.

You can find additional information about transferring license keys in the online help for the Automation License Manager.

Optional expansion of the product bundles

The product bundles can be further expanded:

- SIMATIC PCS 7 Power Packs for visualizing up to 2000 PO (WinCC RT PO (2000))
- SIMATIC PCS 7 Power Packs for configuring PCS 7 plants
- SIMATIC PDM package for PCS 7: starter package with 128 devices; expandable
- PCS 7 Maintenance Station (Asset Management): Full functionality for SIMATIC PCS 7 BOX and lower-level systems

There are the following options with SIMATIC PCS 7 BOX for using a maintenance station in a PCS 7 plant:

- SIMATIC PCS 7 BOX is monitored by a maintenance station in the PCS 7 plant
- SIMATIC PCS 7 BOX is the maintenance station and monitors itself and the lower-level systems (modules and field devices connected to a SIMATIC PCS 7 BOX)

Note
Components that do not belong to this SIMATIC PCS 7 BOX station cannot be diagnosed in the PCS 7 network.

- DC UPS software for further conditioning of the signals on the PC that are sent by the DC UPS module with RS-232 interface
- Optional configuration for SIMATIC PCS 7 BOX 416:
  - SIMATIC BATCH: Up to 10 units (plant sections) controllable (all functions except SIMATIC BATCH API)
  - SIMATIC Route Control: Up to 30 routes controllable

Note
You can find the ordering information for additional PCS 7 software in the catalog ST PCS 7.
Supplied data media

The following data media are supplied with SIMATIC PCS 7 BOX:

- License key diskette
- Restore DVD (Page 145)

Additional information

- ST PCS 7 catalog
- pcs7-readme.chm
- Product information SIMATIC; SIMATIC PCS 7 BOX 416
- Product information SIMATIC; SIMATIC PCS 7 BOX RTX
3.2.3 Compatibility to SIMATIC PCS 7

Functional compatibility with SIMATIC PCS 7

SIMATIC PCS 7 BOX is compatible with SIMATIC PCS 7 and offers the following range of functions:

- SIMATIC PCS 7 BOX offers the functionality of a standard CPU, an OS single-station system (without redundancy), and an engineering station (optional).
- The CPU can communicate with another AS via communication blocks (interconnected in the CFC) and can physically communicate via the Industrial Ethernet interface integrated in the SIMATIC PCS 7 BOX.
- The CPU can communicate with an OS server via the Industrial Ethernet interface integrated in the SIMATIC PCS 7 BOX.
- The "Compile and download objects" function in SIMATIC Manager can be used for the configured CPU.
- The time synchronization for the OS and AS within the SIMATIC PCS 7 BOX PC is performed by a central clock (time master) on the plant bus or by the local PC clock of the SIMATIC PCS 7 BOX PC. You can set the time synchronization of the AS using the "WinAC Time Synchronization" function.
- Diagnostics software is included on the bundle PC so that diagnostics can be performed in relation to the SIMATIC PCS 7 BOX functions.

You will find additional information in the manual titled Process Control System PCS 7; Software Update with Utilization of New Functions.

Properties of SIMATIC PCS 7 BOX

- Configuration: The CPU is listed in HW Config in the catalog under SIMATIC PC Station\Controller\...
- Remote engineering and remote diagnostics via Industrial Ethernet: The SIMATIC PCS 7 BOX CPU can be loaded and diagnosed from a PCS 7 engineering station, which is connected via the Ethernet interface integrated in the SIMATIC PCS 7 BOX PC.
- Only for SIMATIC PCS 7 BOX 416:
  - Plant changes can be made during operation using CiR (Configuration in Run).
  - Add-on package: Batch control is possible using SIMATIC BATCH.
  - Add-on package: Route control is possible using SIMATIC Route Control.
3.3 Configurations with SIMATIC PCS 7 BOX

3.3.1 Configuration options

The following configurations are possible with SIMATIC PCS 7 BOX based on the ordered product bundles:

- **Bundle: SIMATIC PCS 7 BOX as SIMATIC PCS 7 complete system with AS, ES and OS functions:**
  - SIMATIC PCS 7 BOX as a single-station system (Page 26) with AS/ES/OS

- **Bundle: SIMATIC PCS 7 BOX as SIMATIC PCS 7 runtime system with AS, ES and OS functions:**
  - SIMATIC PCS 7 BOX as AS/OS with external engineering (Page 29)
  - SIMATIC PCS 7 BOX as AS/OS in a PCS 7 network (Page 32)

**Note**
The configuration options apply to an OS single-station system.

SIMATIC PCS 7 BOX cannot be used as an OS client or OS server.

Expanded functions with additional software packages

You can install additional packages, such as SIMATIC PDM or SIMATIC BATCH, from the PCS 7 Toolset DVD.

You need the corresponding license key to use these software packages. You can find more information about this in the manual Process Control System PCS 7; PC Configuration and Authorization.

Note on using SIMATIC PDM in the following configurations

You will see dotted lines in the figures for the following configurations. These lines represent the PROFIBUS connection that you need to establish if you wish to use SIMATIC PDM.

Additional information

- Manual Process Control System PCS 7; PC Configuration and Authorization
### 3.3.2 SIMATIC PCS 7 BOX as a single-station system

**SIMATIC PCS 7 BOX as a single-station system**

In this configuration, you use SIMATIC PCS 7 BOX (complete system with ES/OS/AS) as a single-station system.

- With SIMATIC PCS 7 BOX 416, the automation function runs on the CPU integrated in the SIMATIC PCS 7 BOX PC as a PCI card (Slot PLC CPU 416-2 PCI). You connect the distributed I/O to the integrated PROFIBUS DP interfaces on the CPU.
- With SIMATIC PCS 7 BOX RTX, the automation function runs in the installed software PLC WinLC RTX. You connect the distributed I/O via the integrated CP 5613 PROFIBUS DP interface.

You can configure intelligent field devices with SIMATIC PDM via the on-board CP 5611 standard interface.

**Example with SIMATIC PCS 7 BOX 416**

In the figure below, the SIMATIC PCS 7 BOX 416 (complete system with ES/OS/AS) is shown as a single-station system with a connected distributed I/O.
Example with SIMATIC PCS 7 BOX RTX

In the figure below, the SIMATIC PCS 7 BOX RTX (complete system with ES/OS/AS) is shown as a single-station system with a connected distributed I/O.

---

License keys

You need license keys for the following software packages on the SIMATIC PCS 7 BOX PC:

- **ES** (engineering)
- **PCS 7 OS** (process mode)
- For SIMATIC PCS 7 BOX RTX:
  - WinAC; WinAC RTX
  - SIMATIC PCS 7; RTX
  - SIMATIC NET; SIMATIC NET BCE

**Note**

The license keys for the optional add-on product bundles (such as SIMATIC PDM) must be ordered separately.
Operating principle

From the point of view of the PCS 7 project, the SIMATIC PCS 7 BOX station (with integrated CPU [AS]) is not networked. You create and maintain your PCS 7 project on this station and download the PCS 7 project from the ES to the OS and CPU. The program created with SIMATIC PCS 7 runs in the process mode on the OS and CPU.

You can use the Process Device Manager (PDM) to access a PROFIBUS DP line and its stations/devices via the special on-board CP 5611 interface. You can access the CPU in SIMATIC Manager. The communication between the CPU and the integrated PROFIBUS DP interface is performed internally in the PC.

Properties of SIMATIC PCS 7 BOX

- The time synchronization of the OS and the CPU in this configuration is performed using only WinAC time synchronization with the local PC clock because no externally connected clock is included.
- Only for SIMATIC PCS 7 BOX 416:
  - The PROFIBUS DP/MPI interface of the CPU is a functionally sound PROFIBUS DP interface with a limited volume of project data. We recommend that you only connect I/O devices to this interface if they do not require PDM operation.
  - Plant changes can be made during operation using CiR (Configuration in Run).
  - Batch control is possible using SIMATIC BATCH.
  - Route control is possible using SIMATIC Route Control.

Interface properties

You can find additional information on this in the section “Connection to PROFIBUS DP (Page 86)”.
3.3.3 SIMATIC PCS 7 BOX with external engineering

SIMATIC PCS 7 BOX for process mode with external engineering

In this configuration, you use SIMATIC PCS 7 BOX (SIMATIC PCS 7 runtime system with AS and OS functions) exclusively for process mode.

The SIMATIC PCS 7 BOX PC includes an AS/OS single-station system without license keys for engineering. In this case, you configure the SIMATIC PCS 7 BOX station from an external engineering station outside the SIMATIC PCS 7 BOX PC. You have to download the engineering data to the CPU integrated in the SIMATIC PCS 7 BOX. You must also download the visualization data to the PCS 7 OS integrated in the SIMATIC PCS 7 BOX PC.
Example with SIMATIC PCS 7 BOX 416

The following figure represents a SIMATIC PCS 7 BOX 416 (SIMATIC PCS 7 runtime system with AS and OS functions):

- With connected distributed I/O and external engineering
- With a shared bus system for the terminal bus and plant bus

Note

Design with SIMATIC PCS 7 BOX RTX

Compare the figures in the section "SIMATIC PCS 7 BOX as a single-station system (Page 26)".
License keys

You need license keys for the following software packages on the SIMATIC PCS 7 BOX PC:

- PCS 7 OS
- With SIMATIC PCS 7 BOX RTX:
  - WinAC; WinAC RTX
  - SIMATIC PCS 7; RTX
  - SIMATIC NET; SIMATIC NET BCE

Note
The license keys for the optional add-on product bundles (such as SIMATIC PDM) must be ordered separately.

Operating principle

The external ES is networked with the SIMATIC PCS 7 BOX station. The SIMATIC PCS 7 BOX PC is connected to the external engineering station via one of the two on-board Ethernet network interfaces. You use this connection to load the SIMATIC PCS 7 BOX Station (AS and OS). You can use the "Download Changes of OS" function in this configuration.

Properties of SIMATIC PCS 7 BOX

- The time synchronization of the OS and the CPU in this configuration is performed using only WinAC time synchronization with the local PC clock because no externally connected clock is included.
- Only for SIMATIC PCS 7 BOX 416:
  - The PROFIBUS DP/MPI interface of the CPU is functionally a full PROFIBUS DP interface, but is limited by the quantity framework. We recommend that you only connect I/O devices to this interface if they do not require PDM operation.
  - Plant changes can be made during operation using CiR (Configuration in Run).
  - Batch control is possible using SIMATIC BATCH.
  - Route control is possible using SIMATIC Route Control.

Interface properties

You can find information about this in the following sections:

- Section "Connection to PROFIBUS DP (Page 36)"
- Section "Network connection to Industrial Ethernet (Page 40)"
3.3.4 SIMATIC PCS 7 BOX in the PCS 7 network

SIMATIC PCS 7 BOX for process mode in the PCS 7 network

In this configuration, you integrate the SIMATIC PCS 7 BOX station in a PCS 7 network as a PC station with OS/AS. In contrast to the “SIMATIC PCS 7 BOX with external engineering (Page 29)” configuration, here you need two network connections – from the SIMATIC PCS 7 BOX station to the terminal bus and the other to the plant bus. In this configuration, you can synchronize the time of day of the CPU using a time master connected to the plant bus.
**Example with SIMATIC PCS 7 BOX 416**

In the figure below, SIMATIC PCS 7 BOX 416 is shown with a connected distributed I/O in the PCS 7 network.

---

**Note**

**Design with SIMATIC PCS 7 BOX RTX**

Compare the figures in the section "SIMATIC PCS 7 BOX as a single-station system (Page 26)".
License keys

You need license keys for the following software packages on the SIMATIC PCS 7 BOX PC:

- PCS 7 OS
- With SIMATIC PCS 7 BOX RTX:
  - WinAC; WinAC RTX
  - SIMATIC PCS 7; RTX
  - SIMATIC NET BCE

Note
The license keys for the optional add-on product bundles (such as SIMATIC PDM) must be ordered separately.

Operating principle

One of the two on-board Ethernet interfaces on the SIMATIC PCS 7 BOX station is connected to the plant bus of the PCS 7 network. Via this connection path, you download the user program from a central engineering station in the PCS 7 network to the CPU of the SIMATIC PCS 7 BOX station.

You connect the other on-board Ethernet interface on the SIMATIC PCS 7 BOX station to the terminal bus. Via these connection path, you download the OS from a central engineering station in the PCS 7 network.

You can use these two connection paths to create and maintain the program using the external engineering station.
Properties of SIMATIC PCS 7 BOX

- The Ethernet interface to the plant bus and terminal bus are set by default. You can find the default addresses in the product information for the BOX PC.

- The communication (AS to AS) from an AS in the PCS 7 network to the CPU within the SIMATIC PCS 7 BOX station is made possible with the controller software for the CPU (WinAC Slot 416 or software PLC WinLC RTX).

- To enable the PCS 7 maintenance station to show the PDM devices that are connected to the SIMATIC PCS 7 BOX, you have to connect the maintenance client directly to the PROFIBUS DP line of the PDM devices. The PG/PC interface must be set to the CP 5611 PROFIBUS interface.

- No provision is made for communication between the OS in the SIMATIC PCS 7 BOX station and an OS server in the PCS 7 network.

- No provision is made for operation with OpenPCS 7.

- Only for SIMATIC PCS 7 BOX 416:
  - The PROFIBUS DP/MPI interface of the CPU is a functionally sound PROFIBUS DP interface with a limited volume of project data. We recommend that you only connect I/O devices to this interface if they do not require PDM operation.
  - Plant changes can be made during operation using CiR (Configuration in Run).
  - Batch control is possible using SIMATIC BATCH.
  - Route control is possible using SIMATIC Route Control.

Interface properties

You can find information about this in the following sections:

- Section "Connection to PROFIBUS DP (Page 36)"
- Section "Network connection to Industrial Ethernet (Page 40)"
3.4 Connection options for SIMATIC PCS 7 BOX

3.4.1 Connection to PROFIBUS DP

PROFIBUS DP

Use the following PROFIBUS DP interfaces to connect the distributed I/O:

- For SIMATIC PCS 7 BOX 416:
  PROFIBUS DP and PROFIBUS DP/MPI interface on the integrated CPU
  The PROFIBUS DP interface should be used whenever possible.

- For SIMATIC PCS 7 BOX RTX:
  PROFIBUS DP interface of the CP 5613

Properties of the PROFIBUS DP Interfaces for SIMATIC PCS 7 BOX

<table>
<thead>
<tr>
<th>Interface</th>
<th>Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC PCS 7 BOX 416: PROFIBUS DP interface of the CPU</td>
<td>The PROFIBUS DP interface of the CPU is functionally a full PROFIBUS DP interface. You can connect all the I/O devices permitted in SIMATIC PCS 7. Connect I/O devices that require PDM operation to this interface.</td>
</tr>
<tr>
<td>SIMATIC PCS 7 BOX 416: PROFIBUS DP/MPI interface of the CPU</td>
<td>The PROFIBUS DP/MPI interface of the CPU is functionally a full PROFIBUS DP interface, but is limited by the quantity framework. Connect I/O devices that do not require PDM operation to this interface.</td>
</tr>
<tr>
<td>SIMATIC PCS 7 BOX RTX: CP 5613 communications processor</td>
<td>The CP 5613 communication processor has a full PROFIBUS DP interface. You can connect all the I/O devices permitted in SIMATIC PCS 7. Connect I/O devices that require PDM operation to this interface.</td>
</tr>
<tr>
<td>On-board CP 5611 interface</td>
<td>You use the on-board PROFIBUS DP interface CP 5611 exclusively for the configuration with SIMATIC PDM for SIMATIC PCS 7 BOX.</td>
</tr>
</tbody>
</table>
Example for using the PROFIBUS DP interfaces

The connection paths for SIMATIC PCS 7 BOX 416 are shown below:

PROFIBUS PA

A DP/PA Link with a DP/PA coupler is used to connect the PROFIBUS PA to a PROFIBUS DP. You connect the intelligent field devices to the PROFIBUS PA.

Additional information

- Section "Connection of intelligent field devices (Page 38)"
- Section "Network connection to Industrial Ethernet (Page 40)"
3.4.2 Connection of intelligent field devices

Introduction

A DP/PA Link with a DP/PA coupler is used to connect the PROFIBUS PA to a PROFIBUS DP. You connect the intelligent field devices to the PROFIBUS PA.

You assign parameters for the intelligent field devices using the Process Device Manager (SIMATIC PDM).

If you use SIMATIC PDM on a SIMATIC PCS 7 BOX, the on-board CP 5611 PROFIBUS DP interface is only used for assigning parameters for intelligent field devices.

Connection for using SIMATIC PDM

The following connections must be established in order to configure intelligent field devices with SIMATIC PCS 7 BOX:

<table>
<thead>
<tr>
<th>Application</th>
<th>Required connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>For SIMATIC PCS 7 BOX 416</td>
<td>Use a PROFIBUS cable to connect the &quot;on-board CP 5611&quot; interface to the PROFIBUS DP interface of the CPU, via which the intelligent field devices are connected.</td>
</tr>
<tr>
<td>For SIMATIC PCS 7 BOX RTX</td>
<td>Use a PROFIBUS cable to connect the &quot;on-board CP 5611&quot; interface to the PROFIBUS DP interface of the CP 5613, via which the intelligent field devices are connected.</td>
</tr>
</tbody>
</table>
| With external engineering | Connect the PROFIBUS DP connection of the engineering station to the following PROFIBUS DP interface of the SIMATIC PCS 7 BOX station using a PROFIBUS cable:  
  • For SIMATIC PCS 7 BOX 416: PROFIBUS DP interface of the integrated CPU 416-2  
  • For SIMATIC PCS 7 BOX RTX: PROFIBUS DP interface of the CP 5613  
  Note:  
  Use fiber-optic cables for the PROFIBUS connection to perform configuration using SIMATIC PDM, if you require long cable lengths or high speed. |
Setting the access point for using ES/STEP 7 or SIMATIC PDM

With PCS 7, you must set the "S7ONLINE (STEP 7)" access point in the "Set PG/PC Interface" dialog box in accordance with how it is to be used:

- ES/STEP 7:
  If the automation system is to be loaded in the SIMATIC PCS 7 BOX, the access point must be set to "PC-internal (local)".

- SIMATIC PDM:
  If you want to access the PROFIBUS DP line with SIMATIC PDM, the access point must be set to "CP 5611 (DP)".

**NOTICE**

Access point setting

- If the access point for ES/STEP 7 on the CPU remains set to "CP 5611 (DP)", communication is performed via the PROFIBUS DP line. This communication connection is not permitted.
- You can only change the access points when no communication is taking place over the respective interface.

**Additional information**

- Configuration manual *Process Control System PCS 7; Engineering System*
- You will find a list of the connecting cables required for SIMATIC PCS 7 BOX in the catalog *ST PCS 7*. 
3.4.3 Network connection to Industrial Ethernet

Network connection to Industrial Ethernet

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Network connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC PCS 7 BOX as a single-station system</td>
<td>None</td>
</tr>
<tr>
<td>SIMATIC PCS 7 BOX as AS/OS with external engineering</td>
<td>Ethernet interface on-board for common plant/terminal bus</td>
</tr>
<tr>
<td>SIMATIC PCS 7 BOX in the PCS 7 network</td>
<td>• Plant bus via on-board Ethernet interface&lt;br&gt;• Terminal bus via on-board Ethernet interface</td>
</tr>
</tbody>
</table>

Key data for communication

The two on-board Ethernet interfaces of a SIMATIC PCS 7 BOX PC have the following properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>On-board Ethernet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol on the terminal bus (recommended setting)</td>
<td>PCS 7 BOX 416: TCP/IP&lt;br&gt;PCS 7 BOX RTX: TCP/IP</td>
</tr>
<tr>
<td>Protocol on the plant bus (recommended setting)</td>
<td>PCS 7 BOX 416: ISO&lt;br&gt;PCS 7 BOX RTX: TCP/IP</td>
</tr>
<tr>
<td>Time synchronization possible</td>
<td>PCS 7 BOX 416: Yes&lt;br&gt;PCS 7 BOX RTX: Yes</td>
</tr>
<tr>
<td>Number of connections via the CPU</td>
<td>PCS 7 BOX 416: 64&lt;br&gt;PCS 7 BOX RTX: 64</td>
</tr>
<tr>
<td>Configured communication (AS-AS and AS-OS) possible:</td>
<td>Yes&lt;br&gt;PCS 7 BOX RTX: Yes</td>
</tr>
<tr>
<td>• For SIMATIC PCS 7 BOX 416 via Slot PLC CPU 416-2</td>
<td></td>
</tr>
<tr>
<td>• For SIMATIC PCS 7 BOX RTX via software PLC WinLC RTX</td>
<td></td>
</tr>
</tbody>
</table>

Factory state of the SIMATIC PCS 7 BOX PC

Assign the computer name when commissioning the SIMATIC PCS 7 BOX PC.
The "Administrator" password is not pre-selected.

Additional information

- Section "Connection to PROFIBUS DP (Page 36)"
3.5 Operator panel of the CPU

3.5.1 Operator panel of the CPU

Operator panel of the CPU

The operator control and display elements of the CPU can be displayed symbolically on a monitor in the form of an operator panel.

The operator panel can also be controlled via a remote desktop connection.
Structure of SIMATIC PCS 7 BOX

3.5 Operator panel of the CPU
4.1 Introduction

Introduction

The following sections contain the most important information about configuring and commissioning SIMATIC PCS 7 BOX.

Overview

The sections below describe the following configurations:

- Configuring SIMATIC PCS 7 BOX for a single-station system (Page 47)
  You want to create a new project for the single-station system.

- Configuring SIMATIC PCS 7 BOX with external engineering (Page 64)
  You want to create a new project for a Box PC and expand the engineering station.

- Configuring SIMATIC PCS 7 BOX in the PCS 7 network (Page 87)
  You want to expand an existing PCS 7 project with a Box PC.

Configuring the PCS 7 functions

The configuration of the process control system corresponds to the SIMATIC PCS 7 standard:

- Configuring the hardware components in HW Config
- Configuring the connections in NetPro
- Configuring the automation functions in CFC and SFC
- Configuring operator control and monitoring functions in WinCC

Time synchronization

You can find information about how to perform time synchronization of a BOX PC in the function manual Process Control System PCS 7: Time Synchronization.
4.1 Introduction

Additional information

- Configuration manual Process Control System PCS 7; Engineering System
- Configuration manual Process Control System PCS 7; Operator Station
- Online help for HW Config, NetPro, CFC, SFC and WinCC
- Manual Process Control System PCS 7; Getting Started - Part 1
- Product information SIMATIC; SIMATIC PCS 7 BOX 416
- Product information SIMATIC; SIMATIC PCS 7 BOX RTX
- Manual SIMATIC; Windows Automation Center RTX; WinAC RTX
- Manual SIMATIC; Windows Automation Center RTX; Win AC Slot
- Function manual Process Control System PCS 7; Time Synchronization
4.2 Requirements for loading the BOX PC

Consistent configuration

In order to load a BOX PC, the configuration of the components in HW Config and in the Station Configuration Editor must match. You can learn about the steps required prior to loading the BOX PC in the sections dealing with specific configurations.

Name of the BOX PC

Note

Ensure that the names of the PC station match in HW Config and in the configuration in the Station Configuration Editor of SIMATIC PCS 7 BOX.

Configuration in HW Config and in the Station Configuration Editor for SIMATIC PCS 7 BOX 416

The configuration of the SIMATIC PCS 7 BOX 416 in HW Config and in the Station Configuration Editor ("Components" tab) is shown in the following table.

<table>
<thead>
<tr>
<th>HW Config</th>
<th>Station Configuration Editor (&quot;Components&quot; tab)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>Module</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>CPU 416-2 PCI</td>
</tr>
<tr>
<td>4</td>
<td>WinCC application</td>
</tr>
<tr>
<td>5</td>
<td>IE_General</td>
</tr>
</tbody>
</table>
Configuration in HW Config and in the Station Configuration Editor for SIMATIC PCS 7 BOX RTX

The configuration of the SIMATIC PCS 7 BOX RTX in HW Config and in the Station Configuration Editor ("Components" tab) is shown in the following table.

<table>
<thead>
<tr>
<th>HW Config</th>
<th>Station Configuration Editor (&quot;Components&quot; tab)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td><strong>Module</strong></td>
</tr>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>IF1</td>
<td>WinLC RTX CP 5613</td>
</tr>
<tr>
<td>IF2</td>
<td></td>
</tr>
<tr>
<td>IF3</td>
<td></td>
</tr>
<tr>
<td>IF4</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>WinCC application</td>
</tr>
<tr>
<td>4</td>
<td>IE_General (only when plant bus is used)</td>
</tr>
<tr>
<td>5</td>
<td></td>
</tr>
</tbody>
</table>

Windows network settings for SIMATIC PCS 7 BOX RTX

The TCP/IP address must be assigned for the SIMATIC PCS 7 BOX RTX in the Windows network settings and this address must match the one configured in HW Config.

Note
Assigning IP addresses via DHCP

Please ensure that the SIMATIC PCS 7 BOX RTX is always assigned the TCP/IP address configured in HW Config.
4.3 Configuring SIMATIC PCS 7 BOX for a single-station system

4.3.1 Overview of configuration tasks

Requirements

The following software is installed on SIMATIC PCS 7 BOX:

- Operating system
- PCS 7
- Controller:
  - For SIMATIC PCS 7 BOX 416: WinAC Slot 416
  - For SIMATIC PCS 7 BOX RTX: Software PLC WinLC RTX

Overview

The following configuration steps are performed in order to commission SIMATIC PCS 7 BOX for a single-station system:

<table>
<thead>
<tr>
<th>Step</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Creating a new PCS 7 project (Page 48)</td>
</tr>
<tr>
<td>2</td>
<td>Renaming the SIMATIC PC station (Page 49)</td>
</tr>
<tr>
<td>3</td>
<td>Editing the hardware configuration of the BOX PC (Page 50)</td>
</tr>
<tr>
<td>4</td>
<td>Creating the access point for using SIMATIC PDM (Page 51)</td>
</tr>
<tr>
<td>5</td>
<td>Checking the settings of the PG/PC interface (Page 53)</td>
</tr>
<tr>
<td>6</td>
<td>Configuring the Station Configuration Editor</td>
</tr>
<tr>
<td></td>
<td>• For SIMATIC PCS 7 BOX 416 (Page 54)</td>
</tr>
<tr>
<td></td>
<td>• For SIMATIC PCS 7 BOX RTX (Page 56)</td>
</tr>
<tr>
<td>7</td>
<td>Configuring and downloading the BOX PC (Page 58)</td>
</tr>
<tr>
<td>8</td>
<td>Configuring the Automation License Manager (ALM) (Page 59)</td>
</tr>
<tr>
<td></td>
<td>(for SIMATIC PCS 7 BOX 416 only)</td>
</tr>
<tr>
<td>9</td>
<td>Opening the operator panel of the CPU (Page 60)</td>
</tr>
<tr>
<td>10</td>
<td>Compiling and downloading the AS data and OS data (Page 61)</td>
</tr>
<tr>
<td>11</td>
<td>Setting the CPU to RUN mode (Page 63)</td>
</tr>
</tbody>
</table>

Perform the configuration steps listed above in the order they are described.
4.3 Configuring SIMATIC PCS 7 BOX for a single-station system

4.3.2 How to create a new PCS 7 project

Introduction

You create a new PCS 7 project using the PCS 7 "New Project" wizard.

Alternatively, you can add a SIMATIC PCS 7 BOX station to an existing PCS 7 project. This configuration is described in the section "How to expand your PCS 7 project to include a SIMATIC PCS 7 BOX station (Page 91)."

Procedure

1. Open SIMATIC Manager with the menu command Start > SIMATIC > SIMATIC Manager.
2. In SIMATIC Manager, select the menu command File > "New Project" Wizard. The "PCS 7 Wizard 'New Project'", step 1 "Introduction" dialog box opens.
3. Click "Next". The "PCS 7 Wizard 'New Project'", step 2 "Which CPU are you using in your project?" dialog box opens.
4. Select the "PCS7 BOX (...)" item in the "CPU" drop-down list.
5. Select the CPU used in the SIMATIC PCS 7 BOX PC from the "Bundle" list.
   - For SIMATIC PCS 7 BOX 416:
     Select the line with the entry "BOX 416 ...".
   - For SIMATIC PCS 7 BOX RTX:
     Select the line with the entry "BOX RTX ...".
6. Click "Next". The "PCS 7 Wizard 'New Project'", step 3 "Which objects are you still using?" dialog box opens.
7. Accept all default settings and select "PCS 7 OS". Single-station system" is selected.
8. Click "Next". The "PCS 7 Wizard 'New Project'", step 4 "Where do you want to store the multiproject?" dialog box opens.
9. Enter a directory name and the storage location (path) for your PCS 7 project.
10. Click "Finish". Creation of the project begins. The "... _ Message number assignment selection" dialog box opens.
11. Accept the default setting "Assign CPU-oriented unique message numbers". Click "OK". The "PCS 7 Wizard" dialog box displays the progress of the creation of the project.
12. The new PCS 7 project is automatically opened when the "PCS 7 wizard" has created the project.
Result

A project with the given settings and a PC station is created. The PC station is equipped with the following components:

- CPU
  - For SIMATIC PCS 7 BOX 416: Slot PLC "CPU416-2 PCI"
  - For SIMATIC PCS 7 BOX RTX: Software PLC "WinLC RTX"
- WinCC application

Additional information

- Section "How to expand your PCS 7 project to include a SIMATIC PCS 7 BOX station"
- Online help for the PCS 7 Wizard

4.3.3 How to rename the SIMATIC PC station

Introduction

The PCS 7 Wizard has created a new PCS 7 project for you.

The PCS 7 Wizard has automatically assigned a name to the SIMATIC PC station. Adapt this name for the specific project.

Requirements

- The PCS 7 project has been created by the PCS 7 Wizard.
- SIMATIC Manager is open.
- The component view is activated

Procedure

1. In the left window of the component view, open the shortcut menu of the SIMATIC PC station and select the menu command Rename.
2. Enter a name for the specific project.
   
   **Recommendation:** Use the name of the PC under Start > Settings > Control Panel > System > "Computer Name" tab > "Computer name".
3. Click "OK".

Additional information

- Online help for the PCS 7 Wizard
### 4.3.4 How to edit the hardware configuration of the BOX PC

**Introduction**

Once you have created the BOX PC in the SIMATIC Manager, you may need to add additional components in HW Config. Compare the configuration required for the BOX PC with the tables in section "Requirements for loading the BOX PC (Page 45)".

**Requirement**

- The PCS 7 project is displayed in the component view in SIMATIC Manager.

**Procedure**

1. In the component view, select the SIMATIC PC station (SIMATIC PCS 7 BOX) which contains the CPU.
2. Double-click the "Configuration" object in the detail window. The HW Config dialog box opens.
3. If the hardware catalog is not visible, select the menu command **View > Catalog**.
4. Switch to the hardware catalog.
5. Drag and drop the missing components to the respective slots in the station window.
6. Click "OK" to confirm the displayed dialog box.
7. Save and compile your changes.

**Additional information**

- Online help for **HW Config**
4.3.5 How to set the access point on the BOX PC for SIMATIC PDM

Introduction

To access SIMATIC PDM on intelligent field devices which are connected to the PROFIBUS DP, set the access point to "S7ONLINE (STEP 7)".

Requirements

- The engineering station requires a PROFIBUS DP interface (such as CP 5611).
- The PROFIBUS DP connection of the engineering station is connected to the following PROFIBUS DP interface of the SIMATIC PCS 7 BOX station using a PROFIBUS cable:
  - For SIMATIC PCS 7 BOX 416: PROFIBUS DP interface of the integrated CPU 416-2
  - For SIMATIC PCS 7 BOX RTX: CP 5613 (PROFIBUS DP network card in the SIMATIC PCS 7 BOX RTX)
- The configuration in HW Config has been completed, saved and compiled.

Procedure

The procedure is illustrated with an example for the CP 5611 communication processor. Perform this configuration on the engineering station:

1. Select the menu command Start > SIMATIC > SIMATIC NET > Set PC Station. The "Set PC Station" Configuration Console dialog box opens.
2. In the tree view, select the folder PC Station > SIMATIC NET Configuration > Modules > CP 5611 > Address.
3. Enter an available address, such as "3", in the detail view.
4. Check the settings in the "Network Parameters (Page 53)" group.
5. In the tree view, select the folder "PC Station > SIMATIC NET Configuration > Access Point".
6. Select the object "S7ONLINE" in SIMATIC Manager.
7. Select the menu command Action > Properties. The "S7ONLINE" dialog box opens.
8. Select the entry "CP 5611" from the "Assigned Interface Parameter Assignment" drop-down list for access via SIMATIC PDM.
9. Click "OK".
Download the connection in runtime

You can download configured S7 connections within a PCS 7 project in runtime if the tasks described in the sections "How to configure the SIMATIC PCS 7 BOX RTX (Page 56)" and "How to download the BOX PC (Page 58)" have already been performed.

- The access point must be set to "PC internal (local)" to download the AS.
- The communication partner can be either a CPU or a WinCC application.

Use the following procedure:

1. Select the corresponding CPU within a module and select the desired connection in the connection table.
2. Select the menu command **PLC > Download to Current Project > Selected Connections**.

The selected connection is downloaded to both the local and the remote communication partners.
4.3.6 How to check the setting of the access point for the PG/PC interface

Introduction
Before you download the configuration and the program of your PCS 7 project to the CPU, you have to verify that the specified access point of the application and the utilized interface parameter assignment are correct.

Note
As of PCS 7 V7.0, in the factory settings the access point is set to "PC internal (local)".

Requirement
- SIMATIC PCS 7 is installed.

Procedure
1. Select the menu command Start > SIMATIC > SIMATIC NET > Set PC Station. The "Set PC Station' Configuration Console" dialog box opens.
2. In the tree view, select the folder "PC Station > SIMATIC NET Configuration > Access Point".
3. Select the object "S7ONLINE" in the detail window.
4. Select the menu command Action > Properties. The "S7ONLINE" dialog box opens.
5. Select the "S7ONLINE (STEP 7)" entry from the "Assigned interface parameters" dropdown list.
   - Select the entry "PC internal (local)" for downloading the configuration and the program to the CPU.
   - Select the entry "CP 5611 (DP)" for programming and configuration using SIMATIC PDM.

   **NOTICE**

   The access point must be changed.
   - If the access point remains set at "CP 5611 (DP)" and ES/STEP 7 accesses the CPU, communication is performed via the PROFIBUS DP line. This access path is not permitted for PCS 7.
   - You can only change the access point when no communication is taking place over the interface.

6. Click "OK".

Additional information
- Online help on the dialog boxes
4.3 Configuring SIMATIC PCS 7 BOX for a single-station system

4.3.7 How to configure the SIMATIC PCS 7 BOX 416

Requirements

- The PCS 7 project is created.
- The following components are installed on the BOX PC:
  - Operating system
  - PCS 7
  - Controller: WinAC Slot 416
- The components created in the Station Configuration Editor and HW Config match the BOX PC.
- In the dialog box of the "Set PC Station" configuration console, the PC station access point of BOX PC is set to "S7ONLINE: = PC internal (local)".
- If you wish to connect the BOX PC to other network components via Industrial Ethernet, the following requirements also apply:
  - The operating system network is configured.
  - The network addresses of the PC stations are configured.
  - The protocol for communication is set.

Procedure

**Note**
Perform the following tasks first for the engineering station before configuring and downloading additional PC stations.

1. Open the PCS 7 project in SIMATIC Manager.
2. Select the target computer in the component view.
3. Select the menu command PLC > Configure. The "Configure" dialog opens. The PC station selected in the project is entered in the "Target computer" area.

**Note**
If the selected PC station is not entered, this indicates a network problem or a problem in the project configuration.

4. Click "Configure". The "Configure: <Selected Station>" dialog box opens.
5. In the "Configure: Target Computer" dialog box, click "OK".
6. Clock "OK" in the "Information" dialog box. The configuration data are transferred to the PC station. To activate the network connections, you still have to download the network settings to this PC station. The completion of the "Configure" tasks is shown in the status bar of the dialog box.

7. Click "Close".
4.3.8 How to configure the SIMATIC PCS 7 BOX RTX

Requirement

- Perform configuration directly on the BOX PC.
- The following software is installed on SIMATIC PCS 7 BOX RTX:
  - Operating system
  - PCS 7
  - Controller: Software PLC WinLC RTX

Setting the components on the SIMATIC PCS 7 BOX RTX

1. If the CPU is in the RUN operating mode, on the SIMATIC PCS 7 BOX RTX select the menu command CPU > STOP in the operator panel of the CPU. The user program running on the CPU is stopped.
2. Select the menu command CPU > Close Controller. This menu command is only available when the user program of the WinLC RTX software PLC (controller) is in the "started" operating mode.
3. Select the menu command Start > Station Configuration Editor on the SIMATIC PCS 7 BOX RTX.
4. Click on "Station name" and enter the name of the PC station.

Note
This name must match the project-specific name of the PC station in the PCS 7 project.

5. Insert the missing components in the Station Configuration Editor. To do this, click "Add...". The "Add Component" dialog box opens.
6. Select "WinCC Application" as the type and set the same index (slot number), which you have set for the WinCC application in HW Config.
7. Select the WinLC RTX and click "Edit". The "Edit Component" dialog box opens.
8. Click "Properties". The "WinLC Properties" dialog box opens.
   - Select the entry "CP5613A2" in the "Available Adapters" list. Drag and drop the CP to the index IF1.
   - Click "OK". The "WinLC Properties" dialog box closes.
9. Click "OK". The "Edit Components" dialog box closes.
10. Check the configurations in HW Config and in the Station Configuration Editor to ensure they match. The recommended configuration is shown in section “Requirements for loading the BOX PC (Page 45)”.  

**Note**
Ensure that the names of the PC station match in HW Config and in the configuration in the Station Configuration Editor of SIMATIC PCS 7 BOX RTX.

11. Click "OK".  
The Station Configuration Editor closes.

12. On the operator panel of the CPU, select the menu command **CPU > CPU > Start Controller**.  
The "ON" light is green in the "PS" area of the "WinLC RTX" dialog box.

13. Select the menu command **CPU > RUN**.  
The "Startup Type" dialog box opens.

14. Activate the "Restart" check box and click "OK".  
The RUN operating mode is activated.

15. Download the PC station via NetPro.
4.3 Configuring SIMATIC PCS 7 BOX for a single-station system

4.3.9 How to download the BOX PC

Requirements

- The PCS 7 project is created.
- The following components are installed on the BOX PC:
  - Operating system
  - PCS 7
  - Controller:
    - For SIMATIC PCS 7 BOX 416: WinAC Slot 416
    - For SIMATIC PCS 7 BOX RTX: Software PLC WinLC RTX
- The settings on the BOX PC are completed in the Station Configuration Editor (see section "Requirements for loading the BOX PC (Page 45)").
- In the dialog box of the "Set PC Station" configuration console, the PC station access point of BOX PC is set to "S7ONLINE: = PC internal (local)".
- If you wish to connect the BOX PC to other network components via Industrial Ethernet, the following requirements also apply:
  - The operating system network is configured.
  - The network addresses of the PC stations are configured.
  - The protocol for communication is set.

Procedure

**Note**
Perform the following tasks first for the engineering station before configuring and downloading additional PC stations.

1. Open the PCS 7 project in SIMATIC Manager.
2. In the component view, select the SIMATIC PC station (SIMATIC PCS 7 BOX) which contains the CPU.
3. Select the menu command **PLC > Download**.
   The "Download CPU in Current Project" dialog box opens.
4. If the dialog box warns you that the configuration data will be overwritten, make the decision as follows:
   - Click "OK" for initial commissioning.
   - If the PC station is in process mode, you can only click "OK" during an allowed interruption of the communication.
   The "Stop Target Modules" dialog box opens.
5. Click "OK" in the "Stop Target Modules" dialog box to confirm.
   The "Download" dialog box opens.
6. Click "OK" to start the download process.
   The PC station is read for operation once the configuration is loaded.
Switching the logs on the bus (Industrial Ethernet)

**NOTICE**

Never disable the TCP/IP or ISO protocol during operation since they are both needed for the configured operation!

If you want to change a bus in a system to a different protocol (from TCP/IP protocol to ISO protocol, for example), temporarily set a mixed protocol (TCP/IP protocol and ISO protocol) on the engineering station. Then, download the configuration data to all affected systems (for example, the AS and engineering station).

### 4.3.10 How to configure the Automation License Manager for SIMATIC PCS 7 BOX 416

Make the following setting on the BOX PC for SIMATIC PCS 7 BOX to prevent the available license keys from being used by unauthorized persons.

**NOTICE**

This setting only needs to made for SIMATIC PCS 7 BOX 416.

**Procedure**

1. Select the menu command **Start > SIMATIC > License Management > Automation License Manager**. The "Automation License Manager" dialog box opens.
2. Select the menu command **File > Settings**. The "Settings" dialog box opens.
3. Open the "General" tab.
4. Activate the "Forbid License Key transfer to local computer" check box.
5. Click "OK".
4.3.11 How to open the operator panel of the CPU

Introduction

The CPU does not have any display or operator control elements. Therefore, an operator panel which shows all the display and operator control elements exactly like a CPU in an AS is displayed on the computer screen after the CPU has been started. You manipulate the operator control elements on the computer screen with the mouse.

Before downloading the project data to the CPU, check the operating mode of the CPU. You can only download the project data to the CPU when it is in STOP mode.

Requirements

The following software is installed on SIMATIC PCS 7 BOX:

- Operating system
- PCS 7
- Controller:
  - For SIMATIC PCS 7 BOX 416: WinAC Slot 416
  - For SIMATIC PCS 7 BOX RTX: Software PLC WinLC RTX

Procedure

1. Carry out the following in accordance with the BOX PC used:
   - For SIMATIC PCS 7 BOX 416:
     Select the menu command Start > SIMATIC > PC Based Control > CPU 416-2 PCI. The operator panel with the "CPU 416-2 PCI" dialog box opens.
   - For SIMATIC PCS 7 BOX RTX:
     Select the menu command Start > SIMATIC > PC Based Control > WinLC RTX. The operator panel with the "WinLC RTX" dialog box opens.

You can move the operator panel to the desktop and keep it open.

Example: How to stop the automation program on the CPU

1. Click "STOP" in the operator panel of the CPU.
2. Verify that the virtual signal lamp indicates "STOP" mode.

Additional information

- Manual SIMATIC; Windows Automation Center RTX; WinAC RTX
- Manual SIMATIC; Windows Automation Center RTX; Win AC Slot
4.3.12 How to compile and download the AS data and OS data

Introduction

You compile and download the AS data and OS data in the "Compile and Download Objects" dialog box of SIMATIC Manager. You can make all settings conveniently and centrally in this dialog box.

Requirements

- Automation License Manager is installed on the engineering station and the SIMATIC PCS 7 BOX PC.
- SIMATIC Manager is open and your PCS 7 project is displayed in the component view.
- The menu command PLC > Download to Current Project > Selected Stations has been executed in NetPro for a selected SIMATIC station.

Note

During the first download operation, the CPU has to be in STOP mode.
The CPU behaves like a standard CPU in PCS 7.
The CPU of the SIMATIC PCS 7 BOX RTX cannot be configured in RUN mode.

Procedure

1. Select the project in the component view.
2. Select PLC > Compile and Download Objects from the menu .
The "Compile and Download Objects" dialog box opens.
3. Click the plus icon to open all objects in the dialog box.
4. In the tree view of the SIMATIC PC station of SIMATIC PCS 7 BOX, select the "Configuration" object and select the check boxes in the "Compile" and "Download" columns.
5. In the tree view of the SIMATIC PC station of SIMATIC PCS 7 BOX, select the "Charts" object and select the check boxes in the "Compile" and "Download" columns.
6. Click "Edit" in the "Settings for Compilation/Download" group.
The "Compile program/download to target system" dialog box opens.
   - Select the "Compile Charts as Program" tab, then click "Entire program" in the "Scope" group.
   - Select the "S7 Download" tab, then click "Entire program" in the "Download mode" group.
7. Click "OK" to close the "Compile program/download to target system" dialog box.
8. In the tree view of the SIMATIC PC station of SIMATIC PCS 7 BOX, select the "OS ..." object and select the check box in the "Compile" column.

**Note**
The OS does not have to be downloaded since the configuration data are used locally.

9. Click "Edit" in the "Settings for Compilation/Download" group.
The "Settings: Compile OS" dialog box is opened.
- On the "Which areas do you want to assign to which operator stations?" dialog page, click "Next".
- On the "Select the network connections of the S7 programs belonging to the areas" dialog page, click "Next".
- The first time you perform a compilation, on the "Select the data you want to compile and the scope of the compilation" dialog page click "Entire OS" and select the "With memory reset" check box in the "Scope" group.
- Click "Apply".
The project is analyzed and the "Settings: Download OS" dialog box opens.

10. Click "Start" in the "Compile and Download Objects" dialog box.
11. Click "OK" to close the next dialog boxes displayed.
12. Check and close the log file.
13. Click "Close" to close the "Compile and Download Objects" dialog box.

**Additional information**
- Online help on the dialog boxes
4.3.13 How to set the CPU in RUN

Introduction

After you have downloaded the AS data and OS data to the CPU, you still have to set the CPU to RUN mode.

Requirements

- The objects have been compiled and downloaded.
- The operator panel is open and in the foreground.

Procedure

1. Click "RUN" in the operator panel.

Additional information

- Manual SIMATIC; Windows Automation Center RTX; WinAC RTX
- Manual SIMATIC; Windows Automation Center RTX; Win AC Slot
4.4 Configuring SIMATIC PCS 7 BOX with external engineering

4.4.1 Overview of configuration tasks

Introduction

For the “SIMATIC PCS 7 BOX with external engineering” configuration, the engineering station and SIMATIC PCS 7 BOX station must be viewed separately during commissioning and configuration.

Requirements

- The PC stations (engineering station and SIMATIC PCS 7 BOX station) are connected via an administered Windows network.
- The following software is installed on SIMATIC PCS 7 BOX:
  - Operating system
  - PCS 7
  - Controller:
    - For SIMATIC PCS 7 BOX 416: WinAC Slot 416
    - For SIMATIC PCS 7 BOX RTX: Software PLC WinLC RTX

Overview

The following configuration steps are performed in order to commission SIMATIC PCS 7 BOX with external engineering:

<table>
<thead>
<tr>
<th>Step</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Selecting the communication module in SIMATIC Shell (Page 65)</td>
</tr>
<tr>
<td>2</td>
<td>Creating a new PCS 7 project (Page 67)</td>
</tr>
<tr>
<td>3</td>
<td>Renaming the SIMATIC PC station (Page 69)</td>
</tr>
<tr>
<td>4</td>
<td>Expanding the PCS 7 project to include the external ES (Page 70)</td>
</tr>
<tr>
<td>5</td>
<td>Editing the hardware configuration of the PC stations on the ES (Page 71)</td>
</tr>
<tr>
<td>6</td>
<td>Setting the access point on the BOX PC (Page 72)</td>
</tr>
<tr>
<td>7</td>
<td>Configuring NetPro for external engineering (Page 74)</td>
</tr>
<tr>
<td>8</td>
<td>Configuring the Station Configuration Editor</td>
</tr>
<tr>
<td></td>
<td>• For SIMATIC PCS 7 BOX 416 (Page 76)</td>
</tr>
<tr>
<td></td>
<td>• For SIMATIC PCS 7 BOX RTX (Page 78)</td>
</tr>
<tr>
<td>9</td>
<td>Configuring and downloading the BOX PC (Page 80)</td>
</tr>
<tr>
<td>10</td>
<td>Configuring the ALM (Automation License Manager) (Page 82)</td>
</tr>
<tr>
<td></td>
<td>(for SIMATIC PCS 7 BOX 416 only)</td>
</tr>
<tr>
<td>11</td>
<td>Opening the operator panel of the CPU (Page 83)</td>
</tr>
<tr>
<td>12</td>
<td>Compiling and downloading the AS data and OS data (Page 84)</td>
</tr>
<tr>
<td>13</td>
<td>Setting the CPU to RUN mode (Page 85)</td>
</tr>
</tbody>
</table>

Perform the configuration steps listed above in the order they are described.
4.4.2 How to select the communication module in SIMATIC Shell

Introduction
The following describes how to select the communication module to be used to configure the PC stations.

Note
Perform the following steps on the engineering station and the SIMATIC PCS 7 BOX station.

Procedure

1. Double-click on the PC station (workstation) in the tree view of the Windows Explorer.
2. Select the "SIMATIC Shell" folder.
3. Select the Settings... command from the shortcut menu. The "Select Terminal Bus" dialog box opens.
4. Select the network card (communication module) you wish to use for the communication with the engineering station.
   
   Note
   You can find additional information about the defaults of the Ethernet interface in the product information for the BOX PC.

5. Click "OK" to save your entries.

   NOTICE
   When you confirm the next dialog box, the network connection to this PC station is interrupted briefly.

6. Confirm the next dialog box. The network adapter is reinitialized.
7. Select the menu command Start > Settings > Network Connections. The "Network Connections" dialog box opens.
8. Select the menu command Advanced > Advanced Settings. The "Advanced" dialog box opens.
9. Select the "Adapters and Bindings" tab.
10. Ensure that the connection by which the PC station should communicate on the terminal bus is at the top of the "Connections" list. Move this connection to the top of the list if necessary.

**NOTICE**

After new network cards or new network adapters are installed, the most recently entered connection is at the top of the list.

Ensure that the connection by which the PC station communicates on the terminal bus is at the top of the list.

11. Click "OK" to save your entries.
4.4.3 How to create a new PCS 7 project

Introduction

You create a new PCS 7 project using the PCS 7 "New Project" wizard.

Alternatively, you can add a SIMATIC PCS 7 BOX station to an existing PCS 7 project. This configuration is described in the section "How to expand your PCS 7 project to include a SIMATIC PCS 7 BOX station (Page 91)".

Procedure

1. Open SIMATIC Manager with the menu command Start > SIMATIC > SIMATIC Manager.
2. In SIMATIC Manager, select the menu command File > "New Project" Wizard.
   The "PCS 7 Wizard 'New Project'", step 1 "Introduction" dialog box opens.
3. Click "Next".
   The "PCS 7 Wizard 'New Project'", step 2 "Which CPU are you using in your project?" dialog box opens.
4. Select the "PCS7 BOX (…)") item in the "CPU" drop-down list.
5. Select the CPU used in the SIMATIC PCS 7 BOX PC from the "Bundle" list.
   - For SIMATIC PCS 7 BOX 416:
     Select the line with the entry "BOX 416 ...".
   - For SIMATIC PCS 7 BOX RTX:
     Select the line with the entry "BOX RTX ...".
6. Click "Next".
   The "PCS 7 Wizard 'New Project'", step 3 "Which objects are you still using?" dialog box opens.
7. Accept all default settings and select "PCS 7 OS". Single-station system" is selected.
8. Click "Next".
   The "PCS 7 Wizard 'New Project'", step 4 "Where do you want to store the multiproject?" dialog box opens.
9. Enter a directory name and the storage location (path) for your PCS 7 project.
10. Click "Finish".
    Creation of the project begins.
    The "... _ Message number assignment selection" dialog box opens.
11. Accept the default setting "Assign CPU-oriented unique message numbers". Click "OK".
    The "PCS 7 Wizard" dialog box displays the progress of the creation of the project.
12. The new PCS 7 project is automatically opened when the "PCS 7 wizard" has created the project.
Result

A project with the given settings and a PC station is created. The PC station is equipped with the following components:

- **CPU**
  - For SIMATIC PCS 7 BOX 416: Slot PLC "CPU416-2 PCI"
  - For SIMATIC PCS 7 BOX RTX: Software PLC "WinLC RTX"
- WinCC application

Additional information

- Section "How to expand your PCS 7 project to include a SIMATIC PCS 7 BOX station"
- Online help for the PCS 7 Wizard
4.4.4 How to rename the SIMATIC PC station

Introduction

The PCS 7 Wizard has created a new PCS 7 project for you.

The PCS 7 Wizard has automatically assigned a name to the SIMATIC PC station. Adapt this name for the specific project.

Requirements

- The PCS 7 project has been created by the PCS 7 Wizard.
- SIMATIC Manager is open.
- The component view is activated

Procedure

1. In the left window of the component view, open the shortcut menu of the SIMATIC PC station and select the menu command Rename.
2. Enter a name for the specific project.
   Recommendation: Use the name of the PC under Start > Settings > Control Panel > System > "Computer Name" tab > "Computer name".
3. Click "OK".

Additional information

- Online help for the PCS 7 Wizard
4.4.5 How to expand your PCS 7 project to include an engineering station

Introduction

Once you have created the project with the BOX PC using the PCS 7 wizard, create the PC station for the engineering station in the project.

Requirements

- The project with the BOX PC is created.
- The PCS 7 project is displayed in the component view of SIMATIC Manager.

Procedure

1. Select the project folder in the tree view.
2. Select the shortcut menu command Insert New Object > SIMATIC PC Station.
3. Select the newly inserted SIMATIC PC station in the tree view.
4. Select the shortcut menu command Rename.
5. Enter a descriptive name. **Recommendation:** Select the name of the PC under Start > Settings > Control Panel > System > "Computer Name" tab > "Computer name".
6. Click "OK".
4.4.6 How to edit the hardware configuration of the PC stations on the engineering station

Introduction

Once you have created the BOX PC in the SIMATIC Manager, you may add additional components in HW Config. Compare the configuration required for the BOX PC with the tables in section "Requirements for loading the BOX PC (Page 45)".

Requirements

- The ES has been inserted in your PCS 7 project.
- The PCS 7 project is displayed in the component view in SIMATIC Manager.

Procedure

1. In the component view, select the SIMATIC PC station (SIMATIC PCS 7 BOX) which contains the CPU.
2. Double-click the "Configuration" object in the detail window. HW Config opens.
3. If the hardware catalog is not visible, select the menu command View > Catalog.
4. Switch to the hardware catalog.
5. Drag and drop the missing components to the respective slots in the station window.
6. Click "OK".
7. Save and compile your changes.
8. In the component view, select the SIMATIC PC station that represents the ES.
10. Open the "SIMATIC PC Station > CP Industrial Ethernet" folder in the hardware catalog. Select the "IE General" object.
11. Drag the selected CP to a free slot (such as Index 5) in the station window.
12. Click "OK".
13. Save and compile your changes.

Additional information

- Online help for HW Config
4.4.7 How to set the access point on the BOX PC

Introduction
The following describes how to select the access point to be used to configure the PC stations.

Note
Perform the following tasks on the engineering station and the SIMATIC PCS 7 BOX PC.

Selecting an access point
Perform the following steps on all PC stations:
1. Select the menu command Start > SIMATIC > SIMATIC NET > Set PC Station. The "Set PC Station..." Configuration Console dialog box opens.
2. Select the "Access Points" folder in the tree view.
3. In the tree view, select the folder "PC Station > SIMATIC NET Configuration > Access Point".
4. Select the object "S7ONLINE" in the detail window.
5. Select the menu command Action > Properties. The "S7ONLINE" dialog box opens.
6. Select the entry "PC internal (local)" in the "Assigned Interface Parameter Assignment" drop-down list box.
7. Click "OK".

Setting the protocol on the plant bus

Determining the MAC address for ISO protocol on the plant bus
If you want to use the ISO protocol on the plant bus, you need to enter the MAC addresses of the BOX PC's network adapter in HW Config. If you do not know the addresses, do the following on the BOX PC:
1. Select the menu command Start > Run... in the Windows taskbar. The "Run" dialog box opens.
2. Enter the following in the "Open" input box: cmd. Click "OK". A window opens. Click in the window that opens and enter "ipconfig /all".
3. Note the physical address (MAC address) of the access point for the plant bus.
Setting the TCP/IP protocol on the plant bus

If you want to use the TCP/IP protocol on the plant bus, perform the following steps for the network adapter connected to the plant bus:

1. In the Windows taskbar, select the menu command Start > Settings > Network Connections.
   The "Network Connections" dialog box opens.
2. In the detail window select the network connection over which communication is performed on the plant bus.
3. Select the menu command File > Properties.
4. Select the entry "Internet Protocol TCP/IP" from the list.
5. Click "Properties".
6. Set the TCP/IP address:
   Activate the "Use the following IP address" check box and enter the "IP address" and "Subnet mask".
7. Click "OK" twice to apply the settings.
   The TCP/IP address is set.
4.4.8 How to configure NetPro on the external engineering station

Introduction
You assign the modules you are using to networks and create connections in NetPro on the engineering station.

Use of SIMATIC PDM
For the "SIMATIC PCS 7 BOX with external engineering" configuration, you can access intelligent field devices connected to PROFIBUS DP from SIMATIC PDM via the external engineering station.

Note
Observe the permissible cable lengths. For long transfer distances, we recommend using fiber-optic cables as connectors.

Parameter assignment for intelligent field devices via SIMATIC PDM
- You can find information about the required connections in the section "Connection of intelligent field devices (Page 38) "
- You can find information about configuring with SIMATIC PDM via the external engineering station in the section "How to set the access point on the BOX PC for SIMATIC PDM (Page 51) ".

Access to the OS and CPU within the SIMATIC PCS 7 BOX station
You download the OS and user program from the engineering station via the combination plant/terminal bus.

Requirements
- The hardware of the two PC stations has been configured in HW Config on the engineering station.
- The PCS 7 project is displayed in the component view of SIMATIC Manager on the engineering station.
- Connect the PROFIBUS DP connection of the engineering station to the following PROFIBUS DP interface of the SIMATIC PCS 7 BOX station using a PROFIBUS cable:
  - For BOX 416: PROFIBUS DP interface of the integrated CP 416-2
  - For BOX RTX: CP 5613 (PROFIBUS DP interface of SIMATIC PCS 7 BOX RTX)
Procedure

1. Open NetPro with the menu command Options > Configure Network.
2. Close the displayed "Multiproject" dialog box.
3. Open the shortcut menu of the WinCC application in the SIMATIC PC station of the SIMATIC PCS 7 BOX station and select the menu command Insert New Connection.
4. Under the PC station representing the SIMATIC PCS 7 BOX station, select the CPU and leave the other default setting in this dialog box.
5. Click "OK" to close the dialog box.
6. In the "Properties S7 Connection" dialog box, enter a name under "Local ID" in the "Connection Identification" area.
7. Click "OK".
8. Save and compile your changes.
9. Select the SIMATIC station, and select the menu command PLC > Download to Current Project > Selected Connections.
10. Click "Yes" to acknowledge the displayed message box.

Downloading the connection in runtime

You can download configured S7 connections within a PCS 7 project in runtime: The communication partner can be either a CPU or a WinCC application. Use the following procedure:

1. To do so, select the corresponding CPU within a module and select the desired connection in the connection table.
2. Select the menu command PLC > Download to Current Project > Selected Connections.

The selected connection is downloaded to both the local and the remote communication partners.

Additional information

- Online help for NetPro
4.4.9 How to configure the SIMATIC PCS 7 BOX 416

Requirements

- The PCS 7 project is created.
- The following components are installed on the BOX PC:
  - Operating system
  - PCS 7
  - Controller: WinAC Slot 416
- The components created in the Station Configuration Editor and HW Config match the BOX PC.
- In the dialog box of the "Set PC Station" configuration console, the PC station access point of BOX PC is set to "S7ONLINE: = PC internal (local)".
- If you wish to connect the BOX PC to other network components via Industrial Ethernet, the following requirements also apply:
  - The operating system network is configured.
  - The network addresses of the PC stations are configured.
  - The protocol for communication is set.

Procedure

Note
Perform the following tasks first for the engineering station before configuring and downloading additional PC stations.

1. Open the PCS 7 project in SIMATIC Manager.
2. Select the target computer in the component view.
3. Select the menu command PLC > Configure.
   The "Configure" dialog opens. The PC station selected in the project is entered in the "Target computer" area.

Note
If the selected PC station is not entered, this indicates a network problem or a problem in the project configuration.

4. Click "Configure".
   The "Configure: <Selected Station>" dialog box opens.
5. In the "Configure: Target Computer" dialog box, click "OK".
6. Clock "OK" in the "Information" dialog box.
   The configuration data are transferred to the PC station. To activate the network
   connections, you still have to download the network settings to this PC station. The
   completion of the "Configure" tasks is shown in the status bar of the dialog box.

7. Click "Close".
4.4.10 How to configure the SIMATIC PCS 7 BOX RTX

Requirement
- Perform configuration directly on the BOX PC.
- The following software is installed on SIMATIC PCS 7 BOX RTX:
  - Operating system
  - PCS 7
  - Controller: Software PLC WinLC RTX

Setting the components on the SIMATIC PCS 7 BOX RTX

1. If the CPU is in the RUN operating mode, on the SIMATIC PCS 7 BOX RTX select the menu command CPU > STOP in the operator panel of the CPU.
   The user program running on the CPU is stopped.

2. Select the menu command CPU > Close Controller.
   This menu command is only available when the user program of the WinLC RTX software PLC (controller) is in the “started” operating mode.

3. Select the menu command Start > Station Configuration Editor on the SIMATIC PCS 7 BOX RTX.

4. Click on “Station name” and enter the name of the PC station.

Note
This name must match the project-specific name of the PC station in the PCS 7 project.

5. Insert the missing components in the Station Configuration Editor. To do this, click "Add...".
   The "Add Component" dialog box opens.

6. Select "WinCC Application" as the type and set the same index (slot number), which you have set for the WinCC application in HW Config.

7. Select the WinLC RTX and click "Edit".
   The "Edit Component" dialog box opens.

8. Click "Properties".
   The "WinLC Properties" dialog box opens.
   - Select the entry "CP5613A2" in the "Available Adapters" list. Drag and drop the CP to the index IF1.
   - Click "OK".
     The "WinLC Properties" dialog box closes.

9. Click "OK".
   The "Edit Components" dialog box closes.
10. Check the configurations in HW Config and in the Station Configuration Editor to ensure they match. The recommended configuration is shown in section "Requirements for loading the BOX PC (Page 45)".

**Note**
Ensure that the names of the PC station match in HW Config and in the configuration in the Station Configuration Editor of SIMATIC PCS 7 BOX RTX.

11. Click "OK". The Station Configuration Editor closes.
12. On the operator panel of the CPU, select the menu command **CPU > CPU > Start Controller**.
   The "ON" light is green in the "PS" area of the "WinLC RTX" dialog box.
13. Select the menu command **CPU > RUN**.
   The "Startup Type" dialog box opens.
14. Activate the "Restart" check box and click "OK". The RUN operating mode is activated.
15. Download the PC station via NetPro.
4.4.11 How to download the BOX PC

Requirements

- The PCS 7 project is created.
- The following components are installed on the BOX PC:
  - Operating system
  - PCS 7
  - Controller:
    - For SIMATIC PCS 7 BOX 416: WinAC Slot 416
    - For SIMATIC PCS 7 BOX RTX: Software PLC WinLC RTX
- The settings on the BOX PC are completed in the Station Configuration Editor (see section "Requirements for loading the BOX PC (Page 45)").
- In the dialog box of the "Set PC Station" configuration console, the PC station access point of BOX PC is set to "S7ONLINE: = PC internal (local)".
- If you wish to connect the BOX PC to other network components via Industrial Ethernet, the following requirements also apply:
  - The operating system network is configured.
  - The network addresses of the PC stations are configured.
  - The protocol for communication is set.

Procedure

Note
Perform the following tasks first for the engineering station before configuring and downloading additional PC stations.

1. Open the PCS 7 project in SIMATIC Manager.
2. In the component view, select the SIMATIC PC station (SIMATIC PCS 7 BOX) which contains the CPU.
3. Select the menu command **PLC > Download**.
   The "Download CPU in Current Project" dialog box opens.
4. If the dialog box warns you that the configuration data will be overwritten, make the decision as follows:
   - Click "OK" for initial commissioning.
   - If the PC station is in process mode, you can only click "OK" during an allowed interruption of the communication.
   The "Stop Target Modules" dialog box opens.
5. Click "OK" in the "Stop Target Modules" dialog box to confirm.
   The "Download" dialog box opens.
6. Click "OK" to start the download process.
   The PC station is read for operation once the configuration is loaded.
Switching the logs on the bus (Industrial Ethernet)

**NOTICE**

Never disable the TCP/IP or ISO protocol during operation since they are both needed for the configured operation!

If you want to change a bus in a system to a different protocol (from TCP/IP protocol to ISO protocol, for example), temporarily set a mixed protocol (TCP/IP protocol and ISO protocol) on the engineering station. Then, download the configuration data to all affected systems (for example, the AS and engineering station).
4.4.12 How to configure the Automation License Manager for SIMATIC PCS 7 BOX 416

Make the following setting on the BOX PC for SIMATIC PCS 7 BOX to prevent the available license keys from being used by unauthorized persons.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>This setting only needs to be made for SIMATIC PCS 7 BOX 416.</td>
</tr>
</tbody>
</table>

Procedure

1. Select the menu command `Start > SIMATIC > License Management > Automation License Manager`. The "Automation License Manager" dialog box opens.
2. Select the menu command `File > Settings`. The "Settings" dialog box opens.
3. Open the "General" tab.
4. Activate the "Forbid License Key transfer to local computer" check box.
5. Click "OK".
4.4.13 How to open the operator panel of the CPU

Introduction

The CPU does not have any display or operator control elements. Therefore, an operator panel which shows all the display and operator control elements exactly like a CPU in an AS is displayed on the computer screen after the CPU has been started. You manipulate the operator control elements on the computer screen with the mouse.

Before downloading the project data to the CPU, check the operating mode of the CPU. You can only download the project data to the CPU when it is in STOP mode.

Requirements

The following software is installed on SIMATIC PCS 7 BOX:

- Operating system
- PCS 7
- Controller:
  - For SIMATIC PCS 7 BOX 416: WinAC Slot 416
  - For SIMATIC PCS 7 BOX RTX: Software PLC WinLC RTX

Procedure

1. Carry out the following in accordance with the BOX PC used:
   - For SIMATIC PCS 7 BOX 416:
     Select the menu command Start > SIMATIC > PC Based Control > CPU 416-2 PCI. The operator panel with the "CPU 416-2 PCI" dialog box opens.
   - For SIMATIC PCS 7 BOX RTX:
     Select the menu command Start > SIMATIC > PC Based Control > WinLC RTX. The operator panel with the "WinLC RTX" dialog box opens.

You can move the operator panel to the desktop and keep it open.

Example: How to stop the automation program on the CPU

1. Click "STOP" in the operator panel of the CPU.
2. Verify that the virtual signal lamp indicates "STOP" mode.

Additional information

- Manual SIMATIC; Windows Automation Center RTX; WinAC RTX
- Manual SIMATIC; Windows Automation Center RTX; Win AC Slot
4.4.14 How to compile and download the AS data and OS data on an external engineering station

Introduction

The procedure in the "Compile and Download Objects" dialog box for the "SIMATIC PCS 7 BOX with external engineering station" configuration differs from that for a single-station system as follows:

- You need to compile and download both the configuration of the engineering station and the configuration of the SIMATIC PCS 7 BOX station.
- You must compile and download the operator station. To do this, create an appropriate destination folder for the operator station on the SIMATIC PCS 7 BOX station. Then specify the network path from the external engineering station to the operator station.

Requirements

- Automation License Manager is installed on the engineering station and the SIMATIC PCS 7 BOX PC.
- SIMATIC Manager is open and your PCS 7 project is displayed in the component view.
- The CPU is in STOP mode.
- The menu command PLC > Download to Current Project > Selected Connections is executed in NetPro for a selected SIMATIC station.

Note

During the first download operation, the CPU has to be in STOP mode.
The CPU behaves like a standard CPU in PCS 7.
The CPU of the SIMATIC PCS 7 BOX RTX cannot be configured in RUN mode.

Procedure

1. Select the project in the component view.
2. Select the menu command PLC > Compile and Download Objects.
The "Compile and Download Objects" dialog box opens.
3. Click the plus icon to open all objects in the dialog box.
4. In the tree view of the SIMATIC PC station of SIMATIC PCS 7 BOX, select the "Configuration" object and select the check boxes in the "Compile" and "Download" columns.
5. In the tree view of the SIMATIC PC station of SIMATIC PCS 7 BOX, select the "Charts" object and select the check boxes in the "Compile" and "Download" columns.
6. Click "Edit" in the "Settings for Compilation/Download" group. The "Compile Program / Download to Target System" dialog box opens.
   - Select the "Compile Charts as Program" tab, then click "Entire program" in the "Scope" group.
   - Select the "S7 Download" tab, then click "Entire program" in the "Download mode" group.

7. Click "OK" to close the "Compile Program / Download to Target System" dialog box.

8. In the tree view of the SIMATIC PC station of SIMATIC PCS 7 BOX, select the "OS ..." object and select the check boxes in the "Compile" and "Download" columns.

9. Click on the "OS ..." object and then on "Edit" in the "Settings for Compiling/Downloading" group. The "Settings: Compile OS" dialog box is opened.
   - On the "Which areas do you want to assign to which operator stations?" dialog page, click "Next".
   - On the "Select the network connections of the S7 programs belonging to the areas" dialog page, click "Next".
   - The first time you perform a compilation, on the "Select the data you want to compile and the scope of the compilation" dialog page click "Entire OS" and select the "With memory reset" check box in the "Scope" group.
   - Click "Apply". The project is analyzed and the "Settings: Download OS" dialog box opens.
   - Enter the "Path to target OS computer" in the input line and click "The entire WinCC project" in the "Download" group.

10. Click "OK". The "Settings: Download OS" dialog box closes.

11. Click "Start" in the "Compile and Download Objects" dialog box.

12. Click "OK" to close the next dialog boxes displayed.

13. Check and close the log file.

14. Click "Close". The "Compile and Download Objects" dialog box closes.

Additional information
   - Online help on the dialog boxes
4.4.15 How to set the CPU in RUN

Introduction

After you have downloaded the AS data and OS data to the CPU, you still have to set the CPU to RUN mode.

Requirements

- The objects have been compiled and downloaded.
- The operator panel is open and in the foreground.

Procedure

1. Click "RUN" in the operator panel.

Additional information

- Manual SIMATIC; Windows Automation Center RTX; WinAC RTX
- Manual SIMATIC; Windows Automation Center RTX; Win AC Slot
4.5 Configuring SIMATIC PCS 7 BOX in the PCS 7 network

4.5.1 Overview of configuration tasks

Introduction

If you integrate the SIMATIC PCS 7 BOX station in an existing PCS 7 system, you connect the SIMATIC PCS 7 BOX station to the plant bus and terminal bus.

This configuration has the following additional special features:

- The time of day on the AS and OS within the SIMATIC PCS 7 BOX station can be synchronized on the plant bus using a system clock such as SICLOCK TC 400.
- The AS in the PCS 7 network can communicate with the CPU within the SIMATIC PCS 7 BOX station.

Requirements

- The PC stations (engineering station and SIMATIC PCS 7 BOX) are connected via an administered Windows network.
- The following software is installed on SIMATIC PCS 7 BOX:
  - Operating system
  - PCS 7
  - Controller:
    - For SIMATIC PCS 7 BOX 416: WinAC Slot 416
    - For SIMATIC PCS 7 BOX RTX: Software PLC WinLC RTX
Overview

The following configuration steps are performed in order to commission SIMATIC PCS 7 BOX in the PCS 7 network:

<table>
<thead>
<tr>
<th>Step</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Selecting the communication module in SIMATIC Shell (Page 89)</td>
</tr>
<tr>
<td>2</td>
<td>Expanding the PCS 7 project to include a SIMATIC PCS 7 BOX station (Page 91)</td>
</tr>
<tr>
<td>3</td>
<td>Renaming the SIMATIC PC station (Page 93)</td>
</tr>
<tr>
<td>4</td>
<td>Editing the hardware configuration of the BOX PC (Page 94)</td>
</tr>
<tr>
<td>5</td>
<td>Setting the access point on the BOX PC (Page 95)</td>
</tr>
<tr>
<td>6</td>
<td>Configuring NetPro for SIMATIC PCS 7 BOX in the PCS 7 network (Page 97)</td>
</tr>
<tr>
<td>7</td>
<td>Configuring the Station Configuration Editor</td>
</tr>
<tr>
<td></td>
<td>1. For SIMATIC PCS 7 BOX 416 (Page 99)</td>
</tr>
<tr>
<td></td>
<td>2. For SIMATIC PCS 7 BOX RTX (Page 101)</td>
</tr>
<tr>
<td>8</td>
<td>Configuring and downloading the BOX PC (Page 103)</td>
</tr>
<tr>
<td>9</td>
<td>Configuring the ALM (Automation License Manager) (Page 104)</td>
</tr>
<tr>
<td></td>
<td>(for SIMATIC PCS 7 BOX 416 only)</td>
</tr>
<tr>
<td>10</td>
<td>Opening the operator panel of the CPU (Page 105)</td>
</tr>
<tr>
<td>11</td>
<td>Compiling and downloading the AS data and OS data (Page 106)</td>
</tr>
<tr>
<td>12</td>
<td>Setting the CPU to RUN mode (Page 108)</td>
</tr>
</tbody>
</table>

Perform the configuration steps listed above in the order they are described.
4.5.2 How to select the communication module in SIMATIC Shell

Introduction
The following describes how to select the communication module to be used to configure the PC stations.

Note
Perform the following steps on the engineering station and the SIMATIC PCS 7 BOX station.

Procedure

1. Double-click on the PC station (workstation) in the tree view of the Windows Explorer.
2. Select the "SIMATIC Shell" folder.
3. Select the Settings... command from the shortcut menu.
   The "Select Terminal Bus" dialog box opens.
4. Select the network card (communication module) you wish to use for the communication with the engineering station.

   Note
   You can find additional information about the defaults of the Ethernet interface in the product information for the BOX PC.

5. Click "OK" to save your entries.

   NOTICE
   When you confirm the next dialog box, the network connection to this PC station is interrupted briefly.

6. Confirm the next dialog box.
   The network adapter is reinitialized.
7. Select the menu command Start > Settings > Network Connections.
   The "Network Connections" dialog box opens.
8. Select the menu command Advanced > Advanced Settings.
   The "Advanced" dialog box opens.
9. Select the "Adapters and Bindings" tab.
10. Ensure that the connection by which the PC station should communicate on the terminal bus is at the top of the "Connections" list. Move this connection to the top of the list if necessary.

**NOTICE**

After new network cards or new network adapters are installed, the most recently entered connection is at the top of the list.

Ensure that the connection by which the PC station communicates on the terminal bus is at the top of the list.

11. Click "OK" to save your entries.
4.5.3 How to expand your PCS 7 project to include a SIMATIC PCS 7 BOX station

Introduction
You can expand your configured PCS 7 project to include the SIMATIC PCS 7 BOX station. To do this, open the relevant project on the ES in the PCS 7 network.

Requirements
- SIMATIC PCS 7 is installed.
- The PCS 7 project is displayed in the component view.

Procedure
1. Select the project folder in the tree view.
2. Select the shortcut menu command Insert New Object > Preconfigured Station ... > Preconfigured Station. The "PCS 7 Wizard 'Expand Project"", step 1 "Which CPU are you using in your project?" dialog box opens.
3. Select the entry "PCS 7 BOX (...)" from the "CPU" drop-down list and then select the CPU used in the SIMATIC PCS 7 BOX PC from the "Bundle" list:
   - For SIMATIC PCS 7 BOX 416: Select the line with the entry "BOX 416 ...".
   - For SIMATIC PCS 7 BOX RTX: Select the line with the entry "BOX RTX ...".
4. Click "Next". The "PCS 7 Wizard 'Expand Project"", step 2 "Which objects are you still using?" dialog box opens.
5. Click "Next". The "PCS 7 Wizard 'Expand Project"", step 3 "Where do you want to store the multiproject?" dialog box opens.
6. Click "Finish". A SIMATIC PC station with the SIMATIC PCS 7 BOX PC is created in the project.
7. In the tree view select the newly created SIMATIC PC station with the SIMATIC PCS 7 BOX PC.
8. Select the shortcut menu command Rename.
9. Enter a descriptive name.
   Recommendation: Select the name of the SIMATIC PC station under Start > Settings > Control Panel > System > "Computer Name" tab > "Computer name".
10. Open the "SIMATIC PC Station > CP Industrial Ethernet" folder in the hardware catalog. Select the "IE General" object.
11. Drag the selected CP to the "Index 3" slot in the station window.
12. Click "Ok".
13. Enter the network addresses of the SIMATIC PCS 7 BOX PC.
14. Click "OK".
15. Save and compile your changes.

Result

A project with the given settings and a PC station is created. The PC station is equipped with the following components:

- CPU
  - For SIMATIC PCS 7 BOX 416: Slot PLC "CPU416-2 PCI"
  - For SIMATIC PCS 7 BOX RTX: Software PLC "WinLC RTX"
- WinCC application

Additional information

- Online help on the dialog boxes
4.5.4 How to rename the SIMATIC PC station

Introduction

The PCS 7 Wizard has created a new PCS 7 project for you.

The PCS 7 Wizard has automatically assigned a name to the SIMATIC PC station. Adapt this name for the specific project.

Requirements

- The PCS 7 project has been created by the PCS 7 Wizard.
- SIMATIC Manager is open.
- The component view is activated

Procedure

1. In the left window of the component view, open the shortcut menu of the SIMATIC PC station and select the menu command Rename.
2. Enter a name for the specific project.
   Recommendation: Use the name of the PC under Start > Settings > Control Panel > System > "Computer Name" tab > "Computer name".
3. Click "OK".

Additional information

- Online help for the PCS 7 Wizard
4.5.5 How to edit the hardware configuration of the PC stations on the engineering station

Introduction

Once you have created the BOX PC in the SIMATIC Manager, you may add additional components in HW Config. Compare the configuration required for the BOX PC with the tables in section "Requirements for loading the BOX PC (Page 45)".

Requirements

- The ES has been inserted in your PCS 7 project.
- The PCS 7 project is displayed in the component view in SIMATIC Manager.

Procedure

1. In the component view, select the SIMATIC PC station (SIMATIC PCS 7 BOX) which contains the CPU.
2. Double-click the "Configuration" object in the detail window. HW Config opens.
3. If the hardware catalog is not visible, select the menu command View > Catalog.
4. Switch to the hardware catalog.
5. Drag and drop the missing components to the respective slots in the station window.
6. Click "OK".
7. Save and compile your changes.
8. In the component view, select the SIMATIC PC station that represents the ES.
10. Open the "SIMATIC PC Station > CP Industrial Ethernet" folder in the hardware catalog. Select the "IE General" object.
11. Drag the selected CP to a free slot (such as Index 5) in the station window.
12. Click "OK".
13. Save and compile your changes.

Additional information

- Online help for HW Config
4.5.6 How to set the access point on the BOX PC

Introduction
The following describes how to select the access point to be used to configure the PC stations.

Note
Perform the following tasks on the engineering station and the SIMATIC PCS 7 BOX PC.

Selecting an access point
Perform the following steps on all PC stations:

1. Select the menu command Start > SIMATIC > SIMATIC NET > Set PC Station. The "Set PC Station..." Configuration Console dialog box opens.
2. Select the "Access Points" folder in the tree view.
3. In the tree view, select the folder "PC Station > SIMATIC NET Configuration > Access Point".
4. Select the object "S7ONLINE" in the detail window.
5. Select the menu command Action > Properties. The "S7ONLINE" dialog box opens.
6. Select the entry "PC internal (local)" in the "Assigned Interface Parameter Assignment" drop-down list box.
7. Click "OK".

Setting the protocol on the plant bus

Determining the MAC address for ISO protocol on the plant bus
If you want to use the ISO protocol on the plant bus, you need to enter the MAC addresses of the BOX PC's network adapter in HW Config. If you do not know the addresses, do the following on the BOX PC:

1. Select the menu command Start > Run... in the Windows taskbar. The "Run" dialog box opens.
2. Enter the following in the "Open" input box: cmd. Click "OK". A window opens. Click in the window that opens and enter "ipconfig /all".
3. Note the physical address (MAC address) of the access point for the plant bus.
Setting the TCP/IP protocol on the plant bus

If you want to use the TCP/IP protocol on the plant bus, perform the following steps for the network adapter connected to the plant bus:

1. In the Windows taskbar, select the menu command **Start > Settings > Network Connections**. The "Network Connections" dialog box opens.
2. In the detail window select the network connection over which communication is performed on the plant bus.
3. Select the menu command **File > Properties**.
4. Select the entry "Internet Protocol TCP/IP" from the list.
5. Click "Properties".
6. Set the TCP/IP address:
   - Activate the "Use the following IP address" check box and enter the "IP address" and "Subnet mask".
7. Click "OK" twice to apply the settings.
   - The TCP/IP address is set.
4.5.7 How to configure NetPro for SIMATIC PCS 7 BOX in the PCS 7 network

Introduction
You assign the modules you are using to networks and create connections in NetPro on the engineering station.

Use of PDM
For the "SIMATIC PCS 7 BOX in the PCS 7 network" configuration, you can access intelligent field devices connected to PROFIBUS DP from SIMATIC PDM via the external engineering station.

Note
Observe the permissible cable lengths. For long transfer distances, we recommend using fiber-optic cables as connectors.

Parameter assignment for intelligent field devices via SIMATIC PDM
- You can find information about the required connections in the section "Connection of intelligent field devices (Page 38)."
- You can find information about configuring with SIMATIC PDM via the external engineering station in the section "How to set the access point on the BOX PC for SIMATIC PDM (Page 51)."

Access to OS from ES in the PCS 7 network
You use the TCP/IP protocol to access the OS within the SIMATIC PCS 7 BOX station. This connection path is not configured in NetPro but it must be physically present.

Access to the CPU within the SIMATIC PCS 7 BOX station
You download the user program from the engineering station via the plant bus.

Requirements
- The hardware of the two PC stations has been configured in HW Config on the ES.
- The PCS 7 project is displayed in the component view of SIMATIC Manager on the ES.
- Connect the PROFIBUS DP connection of the ES to the following PROFIBUS DP interface of the SIMATIC PCS 7 BOX station using a PROFIBUS cable:
  - For BOX 416: PROFIBUS DP interface of the integrated CPU 416-2
  - For BOX RTX: CP 5613 (PROFIBUS DP interface of SIMATIC PCS 7 BOX RTX)
Commissioning and Configuring SIMATIC PCS 7 BOX

4.5 Configuring SIMATIC PCS 7 BOX in the PCS 7 network

Procedure

1. Open NetPro with the menu command Options > Configure Network.
2. Open the shortcut menu of the WinCC application in the SIMATIC PC station of the SIMATIC PCS 7 BOX station and select the menu command Insert New Connection.
3. Under the PC station representing the SIMATIC PCS 7 BOX station, select the CPU and leave the other default setting in this dialog box.
4. Click "OK" to close the dialog box.
5. In the "Properties S7 Connection" dialog box, enter a name under "Local ID" in the "Connection Identification" area.
6. Click "OK".
7. Save and compile your changes.
8. Select the SIMATIC station, and select the menu command PLC > Download to Current Project > Selected Connections.
9. Click "Yes" to acknowledge the displayed message box.

Downloading the connection in runtime

You can download configured S7 connections within a PCS 7 project in runtime: The communication partner can be either a CPU or a WinCC application. Use the following procedure:

1. Select the corresponding CPU within a module and select the desired connection in the connection table.
2. Select the menu command PLC > Download to Current Project > Selected Connections.

The selected connection is downloaded to both the local and the remote communication partners.

Additional information

- Online help for NetPro
4.5.8 How to configure the SIMATIC PCS 7 BOX 416

Requirements

- The PCS 7 project is created.
- The following components are installed on the BOX PC:
  - Operating system
  - PCS 7
  - Controller: WinAC Slot 416
- The components created in the Station Configuration Editor and HW Config match the BOX PC.
- In the dialog box of the "Set PC Station" configuration console, the PC station access point of BOX PC is set to "S7ONLINE: = PC internal (local)".
- If you wish to connect the BOX PC to other network components via Industrial Ethernet, the following requirements also apply:
  - The operating system network is configured.
  - The network addresses of the PC stations are configured.
  - The protocol for communication is set.

Procedure

Note
Perform the following tasks first for the engineering station before configuring and downloading additional PC stations.

1. Open the PCS 7 project in SIMATIC Manager.
2. Select the target computer in the component view.
3. Select the menu command PLC > Configure. The "Configure" dialog opens. The PC station selected in the project is entered in the "Target computer" area.

Note
If the selected PC station is not entered, this indicates a network problem or a problem in the project configuration.

4. Click "Configure". The "Configure: <Selected Station>" dialog box opens.
5. In the "Configure: Target Computer" dialog box, click "OK".
6. Clock "OK" in the "Information" dialog box. The configuration data are transferred to the PC station. To activate the network connections, you still have to download the network settings to this PC station. The completion of the "Configure" tasks is shown in the status bar of the dialog box.

7. Click "Close".
4.5.9 How to configure the SIMATIC PCS 7 BOX RTX

**Requirement**

- Perform configuration directly on the BOX PC.
- The following software is installed on SIMATIC PCS 7 BOX RTX:
  - Operating system
  - PCS 7
  - Controller: Software PLC WinLC RTX

**Setting the components on the SIMATIC PCS 7 BOX RTX**

1. If the CPU is in the RUN operating mode, on the SIMATIC PCS 7 BOX RTX select the menu command CPU > STOP in the operator panel of the CPU. The user program running on the CPU is stopped.
2. Select the menu command CPU > Close Controller. This menu command is only available when the user program of the WinLC RTX software PLC (controller) is in the "started" operating mode.
3. Select the menu command Start > Station Configuration Editor on the SIMATIC PCS 7 BOX RTX.
4. Click on "Station name" and enter the name of the PC station.

**Note**

This name must match the project-specific name of the PC station in the PCS 7 project.

5. Insert the missing components in the Station Configuration Editor. To do this, click "Add...". The "Add Component" dialog box opens.
6. Select "WinCC Application" as the type and set the same index (slot number), which you have set for the WinCC application in HW Config.
7. Select the WinLC RTX and click "Edit". The "Edit Component" dialog box opens.
8. Click "Properties". The "WinLC Properties" dialog box opens.
   - Select the entry "CP5613A2" in the "Available Adapters" list. Drag and drop the CP to the index IF1.
   - Click "OK". The "WinLC Properties" dialog box closes.
9. Click "OK". The "Edit Components" dialog box closes.
10. Check the configurations in HW Config and in the Station Configuration Editor to ensure they match. The recommended configuration is shown in section "Requirements for loading the BOX PC (Page 45)."

**Note**

Ensure that the names of the PC station match in HW Config and in the configuration in the Station Configuration Editor of SIMATIC PCS 7 BOX RTX.

11. Click "OK".
   The Station Configuration Editor closes.

12. On the operator panel of the CPU, select the menu command **CPU > CPU > Start Controller**.
   The "ON" light is green in the "PS" area of the "WinLC RTX" dialog box.

13. Select the menu command **CPU > RUN**.
   The "Startup Type" dialog box opens.

14. Activate the "Restart" check box and click "OK".
   The RUN operating mode is activated.

15. Download the PC station via NetPro.
4.5.10 How to download the BOX PC

Requirements

- The PCS 7 project is created.
- The following components are installed on the BOX PC:
  - Operating system
  - PCS 7
  - Controller:
    For SIMATIC PCS 7 BOX 416: WinAC Slot 416
    For SIMATIC PCS 7 BOX RTX: Software PLC WinLC RTX
- The settings on the BOX PC are completed in the Station Configuration Editor (see section "Requirements for loading the BOX PC (Page 45)").
- In the dialog box of the “Set PC Station” configuration console, the PC station access point of BOX PC is set to ”S7ONLINE: = PC internal (local)”.  
- If you wish to connect the BOX PC to other network components via Industrial Ethernet, the following requirements also apply:
  - The operating system network is configured.
  - The network addresses of the PC stations are configured.
  - The protocol for communication is set.

Procedure

**Note**

Perform the following tasks first for the engineering station before configuring and downloading additional PC stations.

1. Open the PCS 7 project in SIMATIC Manager.
2. In the component view, select the SIMATIC PC station (SIMATIC PCS 7 BOX) which contains the CPU.
3. Select the menu command **PLC > Download**. The "Download CPU in Current Project" dialog box opens.
4. If the dialog box warns you that the configuration data will be overwritten, make the decision as follows:
   - Click "OK" for initial commissioning.
   - If the PC station is in process mode, you can only click "OK" during an allowed interruption of the communication.
   The "Stop Target Modules" dialog box opens.
5. Click "OK" in the "Stop Target Modules" dialog box to confirm. The "Download" dialog box opens.
6. Click "OK" to start the download process. The PC station is read for operation once the configuration is loaded.
Switching the logs on the bus (Industrial Ethernet)

**NOTICE**

Never disable the TCP/IP or ISO protocol during operation since they are both needed for the configured operation!

If you want to change a bus in a system to a different protocol (from TCP/IP protocol to ISO protocol, for example), temporarily set a mixed protocol (TCP/IP protocol and ISO protocol) on the engineering station. Then, download the configuration data to all affected systems (for example, the AS and engineering station).

4.5.11 How to configure the Automation License Manager for SIMATIC PCS 7 BOX 416

Make the following setting on the BOX PC for SIMATIC PCS 7 BOX to prevent the available license keys from being used by unauthorized persons.

**NOTICE**

This setting only needs to made for SIMATIC PCS 7 BOX 416.

**Procedure**

1. Select the menu command **Start > SIMATIC > License Management > Automation License Manager**.
   The "Automation License Manager" dialog box opens.
2. Select the menu command **File > Settings**.
   The "Settings" dialog box opens.
3. Open the "General" tab.
4. Activate the "Forbid License Key transfer to local computer" check box.
5. Click "OK".
4.5.12 How to open the operator panel of the CPU

Introduction

The CPU does not have any display or operator control elements. Therefore, an operator panel which shows all the display and operator control elements exactly like a CPU in an AS is displayed on the computer screen after the CPU has been started. You manipulate the operator control elements on the computer screen with the mouse.

Before downloading the project data to the CPU, check the operating mode of the CPU. You can only download the project data to the CPU when it is in STOP mode.

Requirements

The following software is installed on SIMATIC PCS 7 BOX:

- Operating system
- PCS 7
- Controller:
  - For SIMATIC PCS 7 BOX 416: WinAC Slot 416
  - For SIMATIC PCS 7 BOX RTX: Software PLC WinLC RTX

Procedure

1. Carry out the following in accordance with the BOX PC used:
   - For SIMATIC PCS 7 BOX 416:
     Select the menu command Start > SIMATIC > PC Based Control > CPU 416-2 PCI. The operator panel with the "CPU 416-2 PCI" dialog box opens.
   - For SIMATIC PCS 7 BOX RTX:
     Select the menu command Start > SIMATIC > PC Based Control > WinLC RTX. The operator panel with the "WinLC RTX" dialog box opens.

You can move the operator panel to the desktop and keep it open.

Example: How to stop the automation program on the CPU

1. Click "STOP" in the operator panel of the CPU.
2. Verify that the virtual signal lamp indicates "STOP" mode.

Additional information

- Manual SIMATIC; Windows Automation Center RTX; WinAC RTX
- Manual SIMATIC; Windows Automation Center RTX; Win AC Slot
4.5.13 How to compile and download the AS data and OS data in the PCS 7 network

Introduction

The procedure in the "Compile and Download Objects" dialog box for the "SIMATIC PCS 7 BOX in the PCS 7 network" configuration differs from that for a single-station system as follows:

- You need to compile and download both the configuration of the ES and the configuration of the SIMATIC PCS 7 BOX station.
- You must compile and download the operator station. To do this, create an appropriate destination folder for the operator station on the SIMATIC PCS 7 BOX station. Then specify the network path from the external engineering station to the operator station.

Requirements

- Automation License Manager is installed on the engineering station and the SIMATIC PCS 7 BOX PC.
- SIMATIC Manager is open and your PCS 7 project is displayed in the component view.
- The menu command PLC > Download to Current Project > Selected Connections is executed in NetPro for a selected SIMATIC station.

Note

During the first download operation, the CPU has to be in STOP mode.

The CPU behaves like a standard CPU in PCS 7.

The CPU of the SIMATIC PCS 7 BOX RTX cannot be configured in RUN mode.

Procedure

1. Select the project in the component view.
2. Select PLC > Compile and Download Objects from the menu.
   The "Compile and Download Objects" dialog box opens.
3. Click the plus icon to open all objects in the dialog box.
4. In the tree view of the SIMATIC PC station of SIMATIC PCS 7 BOX, select the "Configuration" object and select the check boxes in the "Compile" and "Download" columns.
5. In the tree view of the SIMATIC PC station of SIMATIC PCS 7 BOX, select the "Charts" object and select the check boxes in the "Compile" and "Download" columns.
6. Click "Edit" in the "Settings for Compilation/Download" group.
   The "Compile Program/Download to Target System" dialog box opens.
   – Select the "Compile Charts as Program" tab, then click "Entire program" in the "Scope" group.
   – Select the "S7 Download" tab, then click "Entire program" in the "Download mode" group.
7. Click "OK" to close the "Compile Program / Download to Target System" dialog box.
8. Click on the "OS ..." object and then on "Edit" in the "Settings for Compiling/Downloading" group. The "Settings: Compile OS" dialog box is opened.
   - On the "Which areas do you want to assign to which operator stations?" dialog page, click "Next".
   - On the "Select the network connections of the S7 programs belonging to the areas" dialog page, click "Next".
   - The first time you perform a compilation, on the "Select the data you want to compile and the scope of the compilation" dialog page click "Entire OS" and select the "With memory reset" check box in the "Scope" group.
   - Click "Apply". The project is analyzed and the "Settings: Download OS" dialog box opens.
   - Enter the "Path to target OS computer" in the input line and click "The entire WinCC project" in the "Download" group.

9. Click "OK". The "Settings: Download OS" dialog box closes.

10. Click "Start" in the "Compile and Download Objects" dialog box.

11. Click "OK" to close the next dialog boxes displayed.

12. Check and close the log file.

13. Click "Close". The "Compile and Download Objects" dialog box closes.

Additional information
   - Online help on the dialog boxes
4.5.14 How to set the CPU in RUN

Introduction
After you have downloaded the AS data and OS data to the CPU, you still have to set the CPU to RUN mode.

Requirements
- The objects have been compiled and downloaded.
- The operator panel is open and in the foreground.

Procedure
1. Click "RUN" in the operator panel.

Additional information
- Manual SIMATIC; Windows Automation Center RTX; WinAC RTX
- Manual SIMATIC; Windows Automation Center RTX; Win AC Slot
5.1 Introduction

Introduction

The following sections contain general information about the installation of SIMATIC PCS 7 AS RTX.

The response of the SIMATIC PCS 7 AS RTX automation system corresponds to the SIMATIC PCS 7 standard.

Overview

The following topics are discussed in the sections below:

- Hardware and Software Components of SIMATIC PCS 7 AS RTX
- Connection Options for SIMATIC PCS 7 AS RTX
- Operating the CPU

Ordering information

The ST PCS 7 catalog contains ordering information for SIMATIC PCS 7 AS RTX.

Additional information

- Configuration manual Process Control System PCS 7; Engineering System
- Manual SIMATIC; INDUSTRIE PC Microbox ... ; Operating Instructions (e.g. Microbox 427B)
- Manual SIMATIC; Windows Automation Center RTX; WinAC RTX 2008
- Manual SIMATIC; Automation License Manager
5.2 Hardware and Software Components of SIMATIC PCS 7 AS RTX

5.2.1 Hardware Components of SIMATIC PCS 7 AS RTX

Introduction

SIMATIC PCS 7 AS RTX is offered as a bundle with a SIMATIC MICROBOX PC.

Technical features of the employed SIMATIC MICROBOX PC

You can find the technical features of the SIMATIC MICROBOX PC supplied with SIMATIC PCS 7 AS RTX in the ST PCS 7 catalog. This includes the following information:

- General features (processor, working/main memory, graphic controller)
- Drive (Compact Flash card)
- Ports (Ethernet, PROFIBUS DP)
- Serial ports
- USB standard ports (e.g. for mouse and keyboard)

Optional expansion of the product bundle

The product bundle can be further expanded with the following add-ons / expansion components:

- Display and CRT monitors for office and industrial environments
- Keyboard (German or international keyboard layout)
- SITOP modular 20A (power supply)
- SITOP DC UPS module
5.2.2 "SIMATIC". "SIMATIC". Software Components of SIMATIC PCS 7 AS RTX

Introduction

SIMATIC PCS 7 AS RTX is offered as a product bundle with preinstalled software.

Preinstalled software components of SIMATIC PCS 7 AS RTX

The following software components are preinstalled on the Compact Flash card of SIMATIC PCS 7 AS RTX:

- Software for the operating system: Windows XP Professional embedded; Internet Explorer
- Automation License Manager
- Software PLC WinAC RTX
- SIMATIC NET

License key in the SIMATIC PCS 7 AS RTX product package

Note

A license for SIMATIC PCS 7 is issued as a permission to use products. This permission is granted in the form of:

- CoL (Certificate of License) - a legal proof of the ownership of a copyrighted SIMATIC PCS 7 software product.
- License key (authorization code) - technical representation of the license.

The following license keys are included in the standard product package of SIMATIC PCS 7 AS RTX:

- WinAC; WinAC RTX
- SIMATIC PCS 7; RTX
- SIMATIC NET; Industrial Ethernet Softnet S7 Basic

Activating the software components

To unlock software components, transfer the license keys to the SIMATIC PCS 7 AS RTX using the Automation License Manager.

You can find additional information about transferring license keys in the online help for the Automation License Manager.

Optional expansion of the product bundles

The product bundle can be further expanded with the following software components:

- DC UPS software for further conditioning of the signals on the PC that are sent by the DC UPS module with RS-232 interface.
Supplied accessories

The following accessories are included in the bundle for SIMATIC PCS 7 AS RTX:

- Restore USB stick (Page 145)
- License key diskette or license key USB stick

Write protection for Compact Flash card (CF card) using the Enhanced Write Filter (EWF)

The number of write operations for saving data on a Compact Flash card (CF card) is limited. CF card manufacturers specify the guaranteed number of write operations (at least 10,000 write operations are standard). The fewer the write operations that occur and the less the amount of data written, the longer the CF card can be used.

The Enhanced Write Filter (EWF) is a component of the (Windows XP Embedded) operating system of SIMATIC PCS 7 AS RTX. You can use EWF to write-protect the CF card. When EWF is activated, write access operations are redirected to the working memory. No changes can be made to the CF card.

You can find additional information in the section "How to use write protection (EWF) for the Compact Flash card (CF card) (Page 141)".

Additional information

- ST PCS 7 catalog
- pcs7-readme.chm

5.2.3 Compatibility to SIMATIC PCS 7

Functional compatibility with SIMATIC PCS 7

The following functions are compatible with SIMATIC PCS 7:

- The SIMATIC PCS 7 AS RTX automation system is compatible to a standard PCS 7 CPU.
- The CPU can communicate with another AS via communication blocks (interconnected in the CFC) and can physically communicate via the Ethernet interface integrated in the SIMATIC MICROBOX PC.
- The CPU can communicate with an OS server via the Ethernet interface integrated in the SIMATIC MICROBOX PC.
- The "Compile and download objects" function in SIMATIC Manager can be used for the configured CPU.
- You can set the time synchronization of the AS using the "WinAC Time Synchronization" function.
• Diagnostics software is included on the bundle PC so that diagnostics can be performed in relation to the SIMATIC MICROBOX PC functions. You will find additional information in the manual titled *Process Control System PCS 7; Software Update with Utilization of New Functions*.

• You can operate field devices and HART modules on a SIMATIC PCS 7 AS RTX. To monitor these components, the maintenance station must be connected directly to the PROFIBUS DP on which the components are connected.

**Properties of SIMATIC PCS 7 AS RTX**

• Configuration: The CPU is listed in HW Config in the catalog under SIMATIC PC Station\Controller\... .

• The CPU of the SIMATIC PCS 7 AS RTX can be loaded and diagnosed from a PCS 7 engineering station, which is connected via the Ethernet interface integrated in the SIMATIC MICROBOX PC.

• It is not possible to perform plant changes during runtime using CiR (Configuration in Run).

• The performance of the on-board CP 5611 PROFIBUS DP interface is reduced in comparison to other communication processors used with PCS 7: A maximum of 64 DP slaves can be connected.
5.3 Connection Options for SIMATIC PCS 7 AS RTX

5.3.1 Network Connection to Industrial Ethernet

Network connection to Industrial Ethernet

SIMATIC PCS 7 AS RTX is usually connected to the plant bus.

Key data for communication

The SIMATIC MICROBOX PC features two Ethernet ports on board. The two Ethernet on-board ports of the SIMATIC MICROBOX PC have the following properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Ethernet on board</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol on the plant bus</td>
<td>TCP/IP required</td>
</tr>
<tr>
<td></td>
<td>ISO also supported</td>
</tr>
<tr>
<td>Time synchronization possible</td>
<td>Yes</td>
</tr>
<tr>
<td>Configured communication (AS-AS and AS-OS) possible via the WinLC RTX software PLC</td>
<td>Yes</td>
</tr>
<tr>
<td>Number of connection via the CPU</td>
<td>8</td>
</tr>
</tbody>
</table>

Factory state of the SIMATIC PCS 7 AS RTX

The network connections are configured for referencing the network addresses via a DHCP server. The following alternative network addresses are assigned in the factory state:

- Connection Ethernet 1
  network address: "192.168.100.1" (recommendation: connect to the plant bus)

- Connection Ethernet 2 (status: deactivated)
  network address: "192.168.100.2" (deactivated, possibly connect to the terminal bus)

Note

Several SIMATIC PCS 7 AS RTX controllers on the network

Change the PC names and IP addresses as per the requirements for your PCS 7 plant.

Additional information

You can find additional information about the defaults of the Ethernet interfaces in the product information for the SIMATIC PCS 7 AS RTX.
5.3.2 Connecting to PROFIBUS

Introduction
The SIMATIC MICROBOX PC features a PROFIBUS DP interface CP 5611 on board. The distributed I/O is connected to this interface.

The DPV0 and DPV1 protocols are supported.

Additional information
Compatibility to SIMATIC PCS 7 (Page 112)
5.4 Operator Panel of the CPU

5.4.1 Operator panel of the CPU

Operator panel of the CPU

The operator control and display elements of the CPU can be displayed symbolically on a monitor in the form of an operator panel.

The operator panel can also be controlled via a remote desktop connection.
6.1 Overview of configuration tasks

Overview

The configuration of SIMATIC PCS 7 AS RTX is organized into the following tasks.

<table>
<thead>
<tr>
<th>Step</th>
<th>Where?</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Engineering station</td>
<td>Expanding the PCS 7 project to include a SIMATIC PCS 7 AS RTX (Page 118)</td>
</tr>
<tr>
<td>2</td>
<td>Engineering station</td>
<td>Changing the network settings for a remote desktop connection (Page 122)</td>
</tr>
<tr>
<td>3</td>
<td>Engineering station</td>
<td>Configuring the automation functions You can find information on this in the configuration manual Process Control System PCS 7; Engineering System.</td>
</tr>
<tr>
<td>4</td>
<td>Engineering station</td>
<td>Compiling and downloading the AS data (Page 139)</td>
</tr>
<tr>
<td>5</td>
<td>Engineering station</td>
<td>Activating write protection (EWF) for the Compact Flash card (CF card) (Page 141)</td>
</tr>
</tbody>
</table>

Time synchronization

You can find information about how to perform time synchronization of SIMATIC PCS 7 AS RTX in the function manual Process Control System PCS 7; Time Synchronization.

Additional information

- Product information SIMATIC; PCS 7 AS RTX
- Manual SIMATIC; Windows Automation Center RTX; WinAC RTX
- Function manual Process Control System PCS 7; Time Synchronization
6.2 How to expand your PCS 7 project to include a SIMATIC PCS 7 AS RTX

Introduction

You can expand an existing PCS 7 project with a SIMATIC PCS 7 AS RTX. Alternatively, use the PCS 7 "New Project" wizard to create a new PCS 7 project.

Note

This configuration is performed on an engineering station.

Requirements

- SIMATIC PCS 7 is installed.
- The PCS 7 project is displayed in the component view.

Procedure

1. Select the project folder in the tree view.
2. Select the shortcut menu command Insert New Object > Preconfigured Station ... > Preconfigured Station. The "PCS 7 Wizard 'Expand Project'", step 1 "Which CPU are you using in your project?" dialog box opens.
3. Select the entry "PCS 7 BOX (...)" from the "CPU" drop-down list and then select the entry "AS RTX ..." from the "Bundle" list.
4. Click "Next". The "PCS 7 Wizard 'Expand Project'", step 2 "Which objects are you still using?" dialog box opens.
5. Click "Next". The "PCS 7 Wizard 'Expand Project'", step 3 "Where do you want to store the multiproject?" dialog box opens.
6. Click "Finish". A SIMATIC PC station with a WinLC RTX is created in the project.
7. In the tree view select the newly created SIMATIC PC station with the SIMATIC PCS 7 AS RTX.
8. Select the shortcut menu command Rename.
9. Enter a descriptive name. Recommendation: Select the name of the SIMATIC PC station under Start > Settings > Control Panel > System > "Computer Name" tab > "Computer name".
10. Open the "SIMATIC PC Station > CP Industrial Ethernet" folder in the hardware catalog. Select the "IE General" object.
11. Drag the selected CP to the "Index 3" slot in the station window.
12. Click "OK".
13. Enter the name of the SIMATIC PCS 7 AS RTX.
14. Click "OK".
15. Save and compile your changes.

Example

The configuration of the SIMATIC PCS 7 AS RTX in HW Config is shown in the following table:

<table>
<thead>
<tr>
<th>Index/slot</th>
<th>Name</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>WinLC RTX</td>
<td>WinLC RTX</td>
</tr>
<tr>
<td>IF1</td>
<td>CP 5611</td>
<td>CP 5611</td>
</tr>
<tr>
<td>IF2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IF3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IF4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>IE_General</td>
<td>IE_General</td>
</tr>
</tbody>
</table>

Remaining configuration

Note

The remaining configuration is exactly the same as the AS based on SIMATIC S7-400 (NetPro, CFC, etc.).

Additional information

- Configuration manual *Process Control System PCS 7; Engineering System*
6.3 Overview of Commissioning Tasks

Overview

The commissioning of SIMATIC PCS 7 AS RTX is organized into the following tasks. Perform the listed tasks in the order they are described.

Note

Tasks 4 to 13 in the table can be performed on any PC. In this documentation, the settings are made on the engineering station.

<table>
<thead>
<tr>
<th>Step</th>
<th>Where?</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Engineering station</td>
<td>Adapting the network settings of the engineering station (Page 122)</td>
</tr>
<tr>
<td>2</td>
<td>Engineering station</td>
<td>Creating the remote desktop connection to SIMATIC PCS 7 AS RTX (Page 124)</td>
</tr>
<tr>
<td>3</td>
<td>Engineering station or SIMATIC PCS 7 AS RTX</td>
<td>Changing the computer name for SIMATIC PCS 7 AS RTX (Page 126)</td>
</tr>
<tr>
<td>4</td>
<td>Engineering station</td>
<td>Adapting the network addresses (Page 127)</td>
</tr>
<tr>
<td>5</td>
<td>Engineering station</td>
<td>Repairing the network connection on the engineering station (Page 129)</td>
</tr>
<tr>
<td>6</td>
<td>Engineering station or SIMATIC PCS 7 AS RTX</td>
<td>Adapting the settings in the Station Configuration Editor set by factory default for SIMATIC PCS 7 AS RTX (Page 130)</td>
</tr>
<tr>
<td>7</td>
<td>Engineering station</td>
<td>Configuring and downloading the BOX PC (Page 132)</td>
</tr>
<tr>
<td>8</td>
<td>Engineering station or SIMATIC PCS 7 AS RTX</td>
<td>Transferring license keys (Page 134)</td>
</tr>
<tr>
<td>9</td>
<td>Engineering station or SIMATIC PCS 7 AS RTX</td>
<td>Opening the operator panel of the CPU (Page 136)</td>
</tr>
<tr>
<td>10</td>
<td>Engineering station or SIMATIC PCS 7 AS RTX</td>
<td>Activating the “Automatic Start” function (Page 137)</td>
</tr>
</tbody>
</table>
6.4 Options for commissioning a SIMATIC PCS 7 AS RTX

Introduction

In order to establish a network connection to a SIMATIC MICROBOX PC, you need to set up the network connections on the SIMATIC MICROBOX PC.

Options for setting up a SIMATIC PCS 7 AS RTX

<table>
<thead>
<tr>
<th>Options for commissioning</th>
<th>Advantage</th>
<th>Requirement</th>
<th>Further procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decision for setting direct on SIMATIC MICROBOX PC</td>
<td>Fast setting and configuration directly on the SIMATIC PCS 7 AS RTX</td>
<td>Monitor, USB mouse and USB keyboard are connected to the SIMATIC MICROBOX PC.</td>
<td>Section &quot;How to Change the Computer Name for SIMATIC PCS 7 AS RTX (Page 126)&quot;</td>
</tr>
<tr>
<td>Decision for setting via a PC with remote desktop connection</td>
<td>Configuration of a SIMATIC PCS 7 AS RTX in a plant</td>
<td>• Remote desktop connection is established to the SIMATIC PCS 7 AS RTX. • Administrator rights exist on the PC from where SIMATIC PCS 7 AS RTX is to be accessed.</td>
<td>Section &quot;How to set up a remote desktop connection to SIMATIC PCS 7 AS RTX (Page 124)&quot;</td>
</tr>
</tbody>
</table>

Safety information the remote desktop connection to SIMATIC PCS 7 AS RTX

⚠️ CAUTION ⚠️

Ensure you always log on to SIMATIC PCS 7 AS RTX with the same user name.

If you log on to the SIMATIC PCS 7 AS RTX remotely as another user, all processes started by the first user are automatically shut down. For the SIMATIC PCS 7 AS RTX, this means that the CPU goes to STOP.
6.5 How to change the network settings for a remote desktop connection on a PC

Introduction
To establish a connection between two PC stations (for example, an engineering station and SIMATIC PCS 7 AS RTX), you must change the network settings on one PC station if the network settings are not compatible.

Adapting the network settings of the ES to the settings of the SIMATIC PCS 7 AS RTX
If you want to establish a remote desktop connection, you must first change the network settings on the PC station from where a remote desktop connection is to be made. The settings are based on the factory state of the SIMATIC PCS 7 AS RTX.

- IP addresses used by SIMATIC PCS 7 AS RTX: 192.168.100.001 und 192.168.100.002.
- IP address for the engineering station: Selection of a free address in the following address range 192.168.100.xxx (e.g. 192.168.100.100).
- Subnet mask: 255.255.255.000

Note
Ensure that the plant-specific network settings of the PC station from where a remote desktop connection is to be established are backed up.
Note the plant-specific network settings.

Requirements
- The PC stations are connected to the plant bus.
- All remote connections are closed.
- You have administrator rights on the PC station from where a remote desktop connection is to be established with the SIMATIC PCS 7 AS RTX.

Procedure
1. Select the menu command Start > Settings > Network Settings.
2. In the "LAN or High-speed Internet" group, select the network connection through which you want to establish a connection to the SIMATIC PCS 7 AS RTX.
3. Select the menu command File > Properties.
The "Local Area Connection Properties..." dialog box opens.
4. In the list "This connection uses the following items:" select the entry "Internet Protocol TCP/IP".
5. Click "Properties".
The "Internet Protocol (TCP/IP) Properties" dialog box opens.
6. Open the "General" tab.
7. Enter the settings for the network connection.
8. Click "OK".
The "Internet Protocol (TCP/IP) Properties" dialog box closes.

9. Click "OK".

10. Click "OK".
The "Local Area Connection Properties" dialog box closes.

Adapting the network settings of the engineering station to the settings of the plant

When the settings on the remote PC station have been changed, set the original network configuration (plant-specific settings) on the engineering station.
6.6 How to set up a remote desktop connection to SIMATIC PCS 7 AS RTX

Introduction

If there are no HMI equipment (keyboard, mouse, monitor) on the SIMATIC PCS 7 AS RTX, a remote desktop connection to the SIMATIC PCS 7 AS RTX is required in order to make the necessary basic settings for communication to the SIMATIC PCS 7 AS RTX. The procedure is described in this section.

If you the settings for the network connections directly on the SIMATIC MICROBOX PC, proceed with the configuration as described in section "How to Change the Computer Name for SIMATIC PCS 7 AS RTX (Page 126)".

In the following, the engineering station is a PC station from where a remote desktop connection is to be established.

Safety information the remote desktop connection to SIMATIC PCS 7 AS RTX

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensure you always log on to SIMATIC PCS 7 AS RTX with the same user name.</td>
</tr>
<tr>
<td>If other users log on to the SIMATIC PCS 7 AS RTX remotely, all the processes started by the user logged on previously are automatically shut down. For the SIMATIC PCS 7 AS RTX, this means that the CPU goes to STOP.</td>
</tr>
</tbody>
</table>

Factory state of the SIMATIC PCS 7 AS RTX

- The computer name of the SIMATIC PCS 7 AS RTX is: "427B-RTX".
- The SIMATIC PCS 7 AS RTX is assigned to the following work group: "WORKGROUP".
- The password of the "Administrator" administrator is "administrator".
- The network connections are configured for referencing the network addresses via a DHCP server. The following alternative network addresses are assigned:
  - Connection Ethernet 1  
    network address: "192.168.100.1" (recommendation: connect to the plant bus)
  - Connection Ethernet 2  
    network address: "192.168.100.2" (deactivated, possibly connect to the terminal bus)

Note

The network adapters of the SIMATIC PCS 7 AS RTX have an alternative IP address in the band that is not routing-capable (192.168.100.xxx subnet address: 255.255.255.0).
**Requirements**

- SIMATIC PCS 7 AS RTX (SIMATIC MICROBOX PC) and the engineering station are connected via an Ethernet connection (plant bus).
- You are logged on as a user to the engineering station.

**Note**
To increase the security of the plant, change the password of the "Administrator" user.

**Procedure**

1. To open the remote desktop connection, select the menu command Start > Programs > Accessories > Communication > Remote Desktop Connection (2nd option: Start > Run; mstsc then click "OK"). The "Remote Desktop Connection" dialog box opens.
2. Click "Options". The dialog box expands.
3. Open the "General" tab.
4. Enter the following in the "Computer" input box:
   - When logging on to the SIMATIC PCS 7 AS RTX the first time: The network address of the Ethernet connection of the SIMATIC PCS 7 AS RTX through which the SIMATIC PCS 7 AS RTX is connected to the engineering station.
   - After logging on to the SIMATIC PCS 7 AS RTX the first time: The computer name of the SIMATIC PCS 7 AS RTX. The computer name is known only after having logged on to the ES the first time.
5. Open the "Display" tab.
6. In the group "Size of the Remote Desktop", select the entry "1024 x 768 pixels" for the size of the screen.
7. In the group "Colors", select the entry "High Color (16-bit)" from the drop-down list.
8. Open the "Local Resources" tab.
9. In the "Local devices" group, deactivate the "Printer" check box.
10. Open the "Advanced" tab.
11. Select the entry "LAN (10Mbps or higher)" from the drop-down list.
12. Click "Connect". The remote desktop connection opens.
13. Enter the name of the administrator in the "User name" input box.
14. Enter the password of the administrator in the "Password" input box.
15. Click "OK".

**Additional information**

Section "How to Save the Connection Settings to a File" (Page 142)
6.7 How to Change the Computer Name for SIMATIC PCS 7 AS RTX

Introduction

In the following, you will change the computer name for SIMATIC PCS 7 AS RTX.

Requirement

- You can access the SIMATIC PCS 7 AS RTX on the Windows user interface. Options:
  - A remote desktop connection has been established via network connection 1 (plant bus).
  - You have connected a monitor, mouse and keyboard to the SIMATIC PCS 7 AS RTX.

Procedure

1. Select the menu command Start > Settings > Control Panel > System.
   The "System Properties" dialog box opens.
2. Open the "Computer Name" tab.
3. Click "Change".
   The "Change Computer Name" dialog box opens.
4. Enter the desired name of the computer in the "Computer Name" input box.
5. Activate the "Workgroup" check box enter the corresponding name.
6. Click "OK".
   A message dialog informs you changes only take effect after rebooting the PC.
7. Click "OK".
8. Click "Yes" in the "System Properties" dialog box.
   The PC reboots.

The SIMATIC PCS 7 AS RTX is assigned the computer name you have specified following the automatic reboot.

Requirements for reestablishing remote desktop connections

Before reestablishing a remote desktop connection, you need to repair the connection table on the engineering station.

You can find additional information on this in the "How to meet the requirements for reestablishing network connections (Page 129)" section.
6.8 How to Set the Network Addresses of SIMATIC PCS 7 AS RTX

Introduction
In the following, you set up the access point of the PC stations.

Note
Perform the following tasks on the engineering station and the SIMATIC PCS 7 AS RTX.

Requirement
• You can access the SIMATIC PCS 7 AS RTX on the Windows user interface. Options:
  – A remote desktop connection has been established via network connection 1 (plant bus).
  – You have connected a monitor, mouse and keyboard to the SIMATIC PCS 7 AS RTX.

Setting network addresses (IP addresses) for the terminal bus

Note
The settings for the terminal bus are only required if you are going to use it.

1. Select the menu command Start > Settings > Network Connections. The "Network Connections" dialog box opens.
2. In the "LAN or High-speed Internet" group, select network connection 2 "Local Area Connection 2" (terminal bus).
3. Select the menu command File > Properties. The "Local Area Connection 2 Properties" dialog box opens.
4. Select the entry "Internet Protocol TCP/IP" from the list.
5. Click "Properties". The "Internet Protocol (TCP/IP) Properties" dialog box opens.
6. Open the "General" tab.
7. Enter the plant-specific settings for the terminal bus:
   – network settings for operating the SIMATIC PCS 7 AS RTX with a fixed network address or in a domain)
8. Click "OK".
9. Click "OK" in the "Local Area Connection Properties" dialog box.
Setting network addresses (IP addresses) for the plant bus

1. Select the menu command Start > Settings > Network Connections. The "Network Connections" dialog box opens.

2. In the "LAN or High-speed Internet" group, select network connection 1 "Local Area Connection" (plant bus).

3. Select the shortcut menu command Properties. The "Local Area Connection Properties" dialog box opens.

4. In the list "This connection uses the following items:" select the entry "Internet Protocol TCP/IP".

5. Click "Properties". The "Internet Protocol (TCP/IP) Properties" dialog box opens.

6. Open the "General" tab.

7. Enter the plant-specific settings for the plant bus:
   - IP address
   - Subnet mask

8. Click "OK".

9. Click "OK" in the "Local Area Connection Properties" dialog box. If you change the IP address of this Ethernet interface via a remote desktop connection, the remote desktop connection is interrupted.

10. Select the shortcut menu command Close from the title bar.

Note
With a remote desktop connection, Windows shows the cancellation of the remote desktop connection after some time (approximately 10 minutes).

Requirements for reestablishing remote desktop connections

- The tasks described in this section have been performed.
- The connection table must be repaired on the engineering station before you can reestablish a remote desktop connection.
  You can find additional information on this in the section "How to meet the requirements for reestablishing network connections" (Page 129).
6.9 How to meet the requirements for reestablishing network connections

Introduction
You only need to perform this task when commissioning the SIMATIC PCS 7 AS RTX via a remote desktop connection.

If you establish a connection between two PC stations via TCP/IP, a connection table stores the information about this connection. This means that this connection can be quickly reestablished after a brief disruption.

If the connection parameters on a SIMATIC PCS 7 AS RTX have been changed via a remote desktop connection, the information in the connection table of the PC from which the connection was established prevents the connection from being established. In this case the information must first be deleted from the connection table.

Requirements
- The PC stations are connected to a network.
- Any remote desktop connection has been closed.

Procedure
1. On the engineering station, select the menu command Start > Settings > Network Connections.
   The "Network Connections" dialog box opens.
2. Select the network connection for the SIMATIC PCS 7 AS RTX from the list and select the menu command File > Repair.
6.10 How to set the components on the SIMATIC PCS 7 AS RTX

SIMATIC PCS 7 AS RTX is configured with factory defaults for use in PCS 7 plants. The settings of this configuration are contained on the restore USB stick. The following describes how to make these settings.

Name of the SIMATIC PCS 7 AS RTX

Note
Ensure that the names of the PC station match in HW Config and in the configuration in the Station Configuration Editor of SIMATIC PCS 7 AS RTX.

Requirements

- The PCS 7 project is created.
- You can access the SIMATIC PCS 7 AS RTX on the Windows user interface. Options:
  - A remote desktop connection has been established via network connection 1 (plant bus).
  - You have connected a monitor, mouse and keyboard to the SIMATIC PCS 7 AS RTX.
- The operator panel of the CPU of the WinLC RTX software PLC is open.
- In the dialog box of the "Set PC Station" configuration console, the PC station access point of SIMATIC PCS 7 AS RTX is set to "S7ONLINE: = PC internal (local)".

Procedure

1. If the CPU is in the RUN operating mode, select the menu command CPU > STOP in the operator panel of the CPU. The user program running on the CPU is stopped.
2. Select the menu command CPU > Close Controller. This menu command is only available when the user program of the WinLC RTX software PLC (controller) is in the "started" operating mode.
3. Start the Station Configuration Editor with the menu command Start > Station Configuration Editor.
4. Click "Station Name". Enter the name of the SIMATIC PCS 7 AS RTX (SIMATIC MICROBOX PC).

Note
The station name must match the project-specific name of the PC station in the PCS 7 project.
5. Insert the missing components in the Station Configuration Editor (see table):

<table>
<thead>
<tr>
<th>HW Config</th>
<th>Station Configuration Editor (&quot;Components&quot; tab)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>Module</td>
</tr>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>IF1</td>
</tr>
<tr>
<td></td>
<td>IF2</td>
</tr>
<tr>
<td></td>
<td>IF3</td>
</tr>
<tr>
<td></td>
<td>IF4</td>
</tr>
<tr>
<td>3</td>
<td>IE_General</td>
</tr>
</tbody>
</table>

6. Click "Add..." to add missing components. The "Add Component" dialog box opens.

7. Select the entry "IE_General" from the list and set the same index (slot number) which you have set for the component in HW Config.

8. Select "WinLC RTX" from the list. Click "Edit". The "Edit Component" dialog box opens.

9. Click "Properties". The "WinLC Properties" dialog box opens.

10. In the "Available Adapters" group, select "CP5611" and drag it onto the interface slot (IF) where you have configured the on-board CP 5611 of the SIMATIC MICROBOX PC in HW Config.

11. Click "OK". The "WinLC Properties" dialog box closes.

12. Click "OK". The "Edit Components" dialog box closes.

13. Click "OK". The Station Configuration Editor closes.

14. On the operator panel of the CPU, select the menu command CPU > Start Controller. The "ON" light is green in the PS area of the "WinLC RTX" dialog box.

15. Select the menu command CPU > RUN. The "Startup Type" dialog box opens.

16. Activate the "Restart" check box and click "OK". The RUN operating mode is activated.
6.11 How to configure and download a SIMATIC PCS 7 AS RTX

To establish connections between PC stations, transfer the configuration settings to the PC station.

Requirements

- The PCS 7 project is created.
- The following components are installed on SIMATIC PCS 7 AS RTX:
  - Operating system
  - PCS 7
  - Controller: Software PLC WinLC RTX
- The components specific to the PC are configured on the BOX PC for SIMATIC PCS 7 AS RTX with factory defaults (see section "How to configure the SIMATIC PCS 7 BOX RTX (Page 56)").
- In the dialog box of the "Set PC Station" configuration console, the PC station access point of BOX PC is set to "S7ONLINE: = PC internal (local)".
- The operating system network is configured.
- The network addresses of the PC stations are configured.
- The protocol for communication is set.

Note

Perform the following tasks first for the engineering station before configuring and downloading additional PC stations.

Procedure

1. Open the PCS 7 project in SIMATIC Manager.
2. In the component view select the SIMATIC PC station of the SIMATIC PCS 7 AS RTX.
3. Select the menu command PLC > Download.
   The "Download CPU in Current Project" dialog box opens.
4. If the dialog box warns you that the configuration data will be overwritten, make the decision as follows:
   - Click "OK" for initial commissioning.
   - If the PC station is in process mode, you can only click "OK" during an allowed interruption of the communication.
   The "Stop Target Modules" dialog box opens.
5. Click "OK" in the "Stop Target Modules" dialog box to confirm.
   The "Download" dialog box opens.
6. Click "OK" to start the download process.
   The PC station is read for operation once the configuration is loaded.
Switiching the logs on the bus (Industrial Ethernet)

**NOTICE**

Never disable the TCP/IP or ISO protocol during operation since they are both needed for the configured operation!

If you want to change a bus in a system to a different protocol (from TCP/IP protocol to ISO protocol, for example), temporarily set a mixed protocol (TCP/IP protocol and ISO protocol) on the engineering station. Then, download the configuration data to all affected systems (for example, the AS and engineering station).
6.12  How to Transfer the License Keys

Introduction

Use the Automation License Manager to transfer license keys for activating the installed software package.

The license keys for SIMATIC PCS 7 AS RTX are supplied on a license key diskette or a license key USB stick.

The following license keys are included in the standard product package of SIMATIC PCS 7 AS RTX:

- WinAC; WinAC RTX
- SIMATIC PCS 7; RTX
- SIMATIC NET; SIMATIC NET BCE

Requirements

- License keys are available for SIMATIC PCS 7 AS RTX.
- You can access the SIMATIC PCS 7 AS RTX on the Windows user interface. Options:
  - A remote desktop connection has been established via network connection 1 (plant bus).
  - You have connected a monitor, mouse and keyboard to the SIMATIC PCS 7 AS RTX.
- Write protection (EWF) for the Compact Flash card is disabled. You can find additional information in the section "How to use write protection (EWF) for the Compact Flash card (CF card) (Page 141)".

Information on transferring license keys

Possible ways of transferring license keys:

- Transfer the license keys from the license key diskette on the engineering station over the network to the SIMATIC PCS 7 AS RTX.
- Transfer the license keys from the license key USB stick on the SIMATIC PCS 7 AS RTX to the SIMATIC PCS 7 AS RTX.

You can find additional information about transferring license keys in the online help for the Automation License Manager.
Back up license keys

Note
Back up the license keys before performing the following actions on the SIMATIC PCS 7 AS RTX:
- New installation
- Reestablishing the factory state
- Formatting the Compact Flash card
- Defragmenting the Compact Flash card
6.13 How to Open the Operator Panel of the CPU

Introduction

The CPU of the WinLC RTX software PLC has no display or operator control elements. This is why an operator panel is displayed on the computer screen after the CPU starts. This operator panel shows all displays and operator control elements exactly as they appear for a CPU in an AS.

Before downloading the project data to the CPU, check the operating mode of the CPU. You can only download the project data to the CPU when it is in STOP mode.

Requirement

The following software is installed on SIMATIC PCS 7 BOX AS RTX:

- Operating system
- Controller: Software PLC WinLC RTX
- You can access the SIMATIC PCS 7 AS RTX on the Windows user interface. Options:
  - A remote desktop connection has been established via network connection 1 (plant bus).
  - You have connected a monitor, mouse and keyboard to the SIMATIC PCS 7 AS RTX.

Procedure

1. Start the operator panel of the CPU with the menu command Start > SIMATIC > PC Based Control > WinLC RTX.
   The operator panel opens with the "WinLC RTX" dialog box.
   You can move the operator panel on the desktop and keep it open.

Example: How to stop the automation program on the CPU

1. Click "STOP" on the operator panel of the CPU.
2. Verify that the virtual signal lamp indicates "STOP" mode.

Additional information

- Manual SIMATIC; Windows Automation Center RTX; WinAC RTX
6.14 How to activate the automatic start of the AS

Setting the start characteristics of the WinLC RTX software PLC

Note
The start characteristics settings have already been made when the SIMATIC PCS 7 AS RTX is in its factory state.

You can automatically start the CPU of the WinLC RTX software PLC after switching on the SIMATIC MICROBOX PC and set it to the RUN operating mode.

The following settings are necessary for this:

- Register the WinLC RTX software PLC for the automatic start during booting of the SIMATIC MICROBOX PC (PC startup).
- Activate the "Autostart CPU" function of the WinLC RTX software PLC.

"Autostart CPU" function

- If the "Autostart CPU" function is activated, the CPU of the WinLC RTX software PLC starts with the same operating mode (STOP or RUN) which the CPU had before the operator panel closed.
- If the "Autostart CPU" function is deactivated, the CPU of the WinLC RTX software PLC starts in the STOP operating mode.

Requirements

The following software is installed on SIMATIC PCS 7 BOX AS RTX:

- Operating system
- Controller: Software PLC WinLC RTX
- You can access the SIMATIC PCS 7 AS RTX on the Windows user interface. Options:
  - A remote desktop connection has been established via network connection 1 (plant bus).
  - You have connected a monitor, mouse and keyboard to the SIMATIC PCS 7 AS RTX.

Procedure

NOTICE
A user program running in the CPU of the WinLC RTX software PLC is stopped with the following procedure.
1. If the CPU is in the RUN operating mode, select the menu command CPU > STOP. The user program running on the CPU is stopped.

2. Select the menu command CPU > Close Controller. This menu command is only available when the user program of the WinLC RTX software PLC (controller) is in the "started" operating mode.

3. Select the menu command CPU > Register Controller for Start with PC Startup. This menu command is only available when the "Autostart CPU" function is not activated. If the CPU > Register Controller for Start with PC Startup menu command is not available, the controller is already registered for starting with the PC startup.

4. Select the menu command CPU > Start Controller. The "ON" light is green in the PS area of the "WinLC RTX" dialog box.

5. Select the menu command CPU > Tools > Options. The "Options" dialog box opens.

6. Open the "Autostart" tab.

7. Activate the "Autostart CPU" check box.

8. Click "OK" to apply the settings. The "Options" dialog box opens.

9. Select the menu command CPU > RUN. The "Startup Type" dialog box opens.

10. Activate the "Restart" check box and click "OK". The RUN operating mode is activated.
6.15 How to compile and download the AS

Introduction

You download the user program of the SIMATIC PCS 7 AS RTX automation system similar to the way for a S7-400 using the engineering station.

Requirements

- Automation License Manager is installed on the engineering station and the SIMATIC PCS 7 AS RTX.
- The SIMATIC Manager is open and your PCS 7 project is displayed in the component view.
- The CPU is in STOP mode.
- The function **PLC > Download to Current Project > Selected Connections** has been executed in NetPro.

Note

During the first download operation, the CPU has to be in STOP mode.
The CPU behaves like a standard CPU in PCS 7.
The CPU of the SIMATIC PCS 7 AS RTX cannot be configured in RUN mode.

Procedure

1. Select the project in the component view.
2. Select the menu command **PLC > Compile and Download Objects**.
   The "Compile and Download Objects" dialog box opens.
3. Click the plus icon to open all objects in the dialog box.
4. In the tree view of the SIMATIC PCS 7 AS RTX, select the "Configuration" object and activate the check boxes in the "Compile" and "Download" columns.
5. In the tree view of the SIMATIC PCS 7 AS RTX, select the "Charts" object and activate the check boxes in the "Compile" and "Download" columns.
6. Click "Edit" in the "Settings for Compilation/Download" group.
   The "Compile Program / Download to Target System" dialog box opens.
   - Open the "Compile Charts as Program" tab, then click "Entire program" in the "Scope" group.
   - Select the "S7 Download" tab, then click "Entire program" in the "Download mode" group.
7. Click "OK" to close the dialog box.
8. Click "Start" in the "Compile and Download Objects" dialog box.
9. Click "OK" to close the next dialog boxes displayed.
10. Check and close the log file.
11. Click "Close" to close the "Compile and Download Objects" dialog box.

Additional information
- Online help on the dialog boxes
6.16 How to use write protection (EWF) for the Compact Flash card (CF card)

Write protection with Enhanced Write Filter (EWF)

The Enhanced Write Filter (EWF) is a component of the (Windows XP Embedded) operating system of SIMATIC PCS 7 AS RTX. You can use EWF to write-protect the CF card. When EWF is activated, write access operations are redirected to the working memory. No changes can be made to the CF card.

The EWF is activated after a restart of SIMATIC PCS 7 AS RTX.

Requirements

The following software is installed on SIMATIC PCS 7 BOX AS RTX:
- Operating system
- Controller: Software PLC WinLC RTX
- You can access the SIMATIC PCS 7 AS RTX on the Windows user interface. Options:
  - A remote desktop connection has been established via network connection 1 (plant bus).
  - You have connected a monitor, mouse and keyboard to the SIMATIC PCS 7 AS RTX.

Procedure

1. Select the menu command Start > SIMATIC > Manage AS-RTX.
   - After activating the EWF, select the menu command EWF for C ON.
   - To deactivate the EWF, select the menu command EWF for C OFF.
2. Reboot the SIMATIC PCS 7 AS RTX.

Checking the status of the Enhanced Write Filter (EWF)

1. Select the menu command Start > SIMATIC > Manage AS-RTX > EWF State.

Notes on operation with an activated EWF filter

- If the EWF filter is activated, no further changes may be made in the Station Configuration Editor.
- To load changes made to the hardware via HW Config, only the entry "WinLC RTX" may be selected in the "Target Group" dialog box.
- Only connections can be loaded via NetPro.
6.17 Additional Information on Working with Remote Desktop Connections

6.17.1 How to Save the Connection Settings to a File

Introduction

To be able to open remote desktop connections without having to repeatedly enter all connection parameters, save the connection parameters in an RDP file (connection file for the Remote Desktop Protocol). The connection file contains all information about the settings required for establishing a connection to other PC stations.

A default connection file (Default.rdp) is saved as a hidden file in the "My Files" folder. You can create additional connection files in which the settings can differ.

Requirement

- The PC stations are connected to a network.

Procedure

1. To open the remote desktop connection, select the menu command Start > Programs > Accessories > Communication > Remote Desktop Connection. The "Remote Desktop Connection" dialog box opens.
2. Click "Options".
3. Enter the desired settings for this connection (for example, screen size, information for automatic logon and performance options). You can find additional information on this in the section "How to set up a remote desktop connection to SIMATIC PCS 7 AS RTX (Page 124)".

   NOTICE

   All entries made are saved in the connection file. For security reasons, do not save the password.

4. Open the "General" tab.
5. Click "Save As".
6. Enter a name for the connection file to be saved.
7. Click "Save".

Editing the connection file

1. Select the connection file in the Windows Explorer, and then select the shortcut menu command Edit.
6.17.2 How to close a connection without stopping ongoing processes

Introduction

An application started on the SIMATIC PCS 7 AS RTX is not ended when you close the remote desktop connection. It does not matter when the application started:

- The application was started before the remote desktop connection was established.
- The application was started after the remote desktop connection was established.

Note

If you close a remote desktop connection by closing the dialog box, the processes on the remote PC stations do not end.

Requirements

- The PC stations are connected to a network.
- A remote desktop connection has been established.

Procedure

1. Select the menu command Start > Disconnect in the "Remote Desktop Connection" dialog box.
   The "Disconnect Windows" dialog box opens.
2. Click "Disconnect".

6.17.3 How to Open a Saved Connection

Introduction

You can open a remote desktop connection by calling up the associated connection file.

Requirements

- The PC stations are connected to a network.
- A connection file has been saved.

Procedure

1. Open the Windows Explorer and select the folder in which the connection file is saved.
2. Double-click on the connection file for the desired remote desktop connection.
6.17.4 How to Perform a Restart via a Remote Desktop Connection

Introduction

You can initiate a restart of a SIMATIC PCS 7 AS RTX via the remote desktop connection.

Requirements

- The PC stations are connected to a network.
- A remote desktop connection has been established.

Procedure

1. Click the window of the remote desktop connection.
2. Select the menu command Start > SIMATIC > Manage AS-RTX > RESTART SYSTEM in the Windows taskbar.

Note

Switching off the MICROBOX PC

Select the menu command Start > SIMATIC > Manage AS-RTX > SHUT DOWN SYSTEM in the Windows taskbar.
Establishing the factory state

7.1 Establishing the factory state

Supplied restore images

- Restore images are supplied on the following two Restore DVDs with the bundle of a SIMATIC PCS 7 BOX PC:
  - Restore DVD "A1": This DVD only contains the Windows operating system (with adaptations for PCS 7)
  - Restore DVD "A2": This DVD contains a restore image of the SIMATIC PCS 7 BOX PC in the factory state.
- A restore image is provided on a USB stick with the SIMATIC PCS 7 AS RTX bundle.

Restoring the factory state

You can find information about using the restore image in the product information.

NOTICE

Backing up license keys

Back up the license keys before installing the restore images.

Additional information

- Product information SIMATIC; SIMATIC PCS 7 BOX 416
- Product information SIMATIC; SIMATIC PCS 7 BOX RTX
- Product information SIMATIC; SIMATIC PCS 7 AS RTX
Establishing the factory state

7.1 Establishing the factory state
Index

A

AS data, 61, 84, 106
  Compiling and downloading for external engineering, 84
  Compiling and downloading in the PCS 7 network, 106
  Compiling and downloading in the single-station system, 61
AS RTX, 118, 121, 134, 137, 139, 143
  Activating automatic start of the AS, 137
  Administration options, 121
  Closing a remote connection, 143
  Compile and download, 139
  Create project, 118
  Transferring license key, 134

B

BOX PC, 18, 20
  Hardware components, 18
  License keys, 20
  Preinstalled software, 20
  Software components, 20

C

CF card
  Write protection, 141
Changing the computer name, 126
Changing the computer name for SIMATIC PCS 7 AS RTX, 126
Checking, 53
  PG/PC interface for single-station system, 53
Communication modules, 65, 89
  Selecting in SIMATIC Shell for external ES, 65, 89
Compile and download, 84, 139
  AS RTX in the PCS 7 network, 139
Compiling and downloading, 61, 106
  AS data for external engineering, 84
  AS data in the PCS 7 network, 106
  AS data in the single-station system, 61
  OS data for external engineering, 84
  OS data in the PCS 7 network, 106
  OS data in the single-station system, 61
Configuration, 49, 69, 93
  Configuration options, 25
  SIMATIC PCS 7 BOX, 25
Configuration tasks, 47, 84, 87
  Overview for a single-station system, 47
  Overview in the PCS 7 network, 87
  Overview of external engineering, 64
Configuration variants, 20
  SIMATIC PCS 7 BOX, 20
Configuring, 51, 72, 74, 95, 97
  NetPro for SIMATIC PDM as a single-station system, 51
  NetPro in the PCS 7 network, 97
  NetPro with external engineering, 74
  PC station in the Configuration Console for external ES, 72, 95
Connecting, 36, 40, 114, 115
  SIMATIC PCS 7 BOX to Ethernet, 40, 114
  SIMATIC PCS 7 BOX to PROFIBUS, 115
  SIMATIC PCS 7 BOX to PROFIBUS DP, 36
CPU, 63, 86, 108
  Setting to RUN in the single station, 63, 86, 108
Creating, 48, 67
  PCS 7 project, 48, 67
  Creating a new PCS 7 project, 48, 67
  Creating a remote desktop connection, 124

E

Editing, 50, 71, 94
  Hardware configuration of the PC stations with external ES, 50, 71, 94
Ethernet, 40, 114
  Connecting SIMATIC PCS 7 BOX, 40, 114
EWF, 141
Expansion, 70, 91
  Expanding PCS 7 project with external ES, 70
  PCS 7 project with SimATIC PCS 7 BOX station in the PCS 7 network, 91
External engineering, 43
  Configuring NetPro, 74
External engineering, 17, 29, 50, 84, 85, 70, 71, 72
  Configuring the PC station in the Configuration Console, 72
  Editing the hardware configuration of the PC stations, 50, 71
  Expanding PCS 7 project with external ES, 70
Hardware and software installation, 43
Operating principle, 29
Overview of configuration tasks, 64
Restrictions, 29
Selecting communication module in SIMATIC Shell, 65
Special features, 29
External engineering, 74
External engineering, 84
External engineering
  Compiling and downloading AS and OS data, 84
External engineering, 89
External engineering
  Selecting communication module in SIMATIC Shell, 89
External engineering, 94
External engineering
  Editing the hardware configuration of the PC stations, 94
External engineering
  Configuring the PC station in the Configuration Console, 95
External engineering, 95
External engineering
  Hardware and software installation, 109
External engineering, 109

 Hardware components, 18
  BOX PC, 18
  SIMATIC PCS 7 BOX, 18
Update, 18
Hardware components of the AS RTX, 110
Hardware installation, 17, 43, 109
  external engineering, 17
  external engineering, 43
  External engineering, 109
How to change the network settings for a remote desktop connection on a PC, 122

L
License keys
  BOX PC, 20
  SIMATIC PCS 7 BOX, 20

N
NetPro, 51, 74, 97
  Configuring for SIMATIC PDM as a single-station system, 51
  Configuring in the PCS 7 network, 97
  Configuring with external engineering, 74
Network connections
  Reestablishing, 129

O
Open
  Operator Panel of the CPU, 136
  Opening, 60, 83, 105, 136
    Operator panel of the CPU, 60, 83, 105
    Opening a saved connection, 143
  Operating principle, 29, 32
    SIMATIC PCS 7 BOX in the PCS 7 network, 32
    With external engineering, 29
  Operator panel, 41, 116
    Opening the CPU 416-2 PCI, 60, 83, 105, 136
OS data, 61, 84, 106
  Compiling and downloading for external engineering, 84
  Compiling and downloading in the PCS 7 network, 106
  Compiling and downloading in the single-station system, 61
Overview, 47, 64, 87
  Configuration tasks for a single-station system, 47
  Configuration tasks for external ES, 64
  Configuration tasks for the PCS 7 network, 87
Overview of Commissioning Tasks, 120
Overview of configuration tasks, 117.
Overview of Configuration Tasks, 117
P
Parameter assignment for intelligent field devices via SIMATIC PDM, 38
PCS 7 AS RTX
  Computer name, 126
PCS 7 network, 32, 87, 91, 97, 106
  Compiling and downloading AS and OS data, 106
  Configuring NetPro in the PCS 7 network, 97
  Expanding PCS 7 project with SIMATIC PCS 7 BOX, 91
  Method of operation for SIMATIC PCS 7 BOX, 32
  Overview of configuration tasks, 87
  Restrictions of SIMATIC PCS 7 BOX, 32
  Special features in comparison to SIMATIC PCS 7 BOX, 32
PCS 7 project, 48, 67, 70, 118
  Creating, 48, 67
  Creating for AS RTX, 118
  Expanding with external ES, 70
PDM, 74, 97
  Preparation - external ES, 74
  Preparations in the network, 97
PG/PC interface, 53
  Checking for single-station system, 53
PROFIBUS, 115
  Connecting SIMATIC PCS 7 BOX, 115
PROFIBUS DP, 36
  Connecting SIMATIC PCS 7 BOX, 36

S
Saving the connection settings to a file, 142
Selection, 65, 89
  Communication module in SIMATIC Shell for external ES, 65, 89
Setting, 63, 86, 108
  CPU to RUN in the single-station system, 63, 86, 108
Setting up configuration console, 127
  AS RTX, 127
SIMATIC PC station, 49, 69, 93
  Renaming, 49, 69, 93
SIMATIC PCS 7, 24, 112
  Functional compatibility with SIMATIC PCS 7 BOX, 24, 112
  Restrictions in relation to SIMATIC PCS 7 BOX, 24
  Restrictions when compared to SIMATIC PCS 7 BOX, 112
  Special features in comparison to SIMATIC PCS 7 BOX, 24, 112
SIMATIC PCS 7 BOX, 18, 20, 25, 26, 29, 32, 36, 40, 114, 115
  As single-station system, 26
  Configuration options, 25
  Configuration variants, 20
  Connecting to Ethernet, 40, 114
  Connecting to PROFIBUS, 115
  Connection to PROFIBUS DP, 36
  Hardware components, 18
  In the PCS 7 network, 32
  License keys, 20
  Preinstalled software, 20
  Software components, 20
  With external engineering, 29
SIMATIC PDM, 25, 51
  Notes on configuration, 25
  Preparation on single-station system, 51
Single-station system, 26, 47, 51, 53, 61, 63, 86, 108
  Checking PG/PC interface, 53
  Compiling and downloading AS and OS data, 61
  Configuring NetPro for SIMATIC PDM, 51
  Overview of configuration tasks, 47
  Restrictions, 26
  Setting CPU to RUN, 63, 86, 108
  SIMATIC PCS 7 BOX, 26
  Special features, 26

Restrictions, 24, 26, 29, 32, 112
  Compared to SIMATIC PCS 7, 112
  SIMATIC PCS 7 BOX in the PCS 7 network, 32
Single-station system, 26
  With external engineering, 29
  with SIMATIC PCS 7, 24

SIMATIC PCS 7 BOX, 26
Function Manual, 03/2009, A5E02122509-01
Index

Software, 145
  Updating, 145
Software components, 20
  SIMATIC PCS 7 BOX, 20
Software components of the AS RTX, 111
Software installation, 17, 43, 109
  external engineering, 17, 43
  External engineering, 109
Special features, 24, 26, 29, 32, 112
  Compared to SIMATIC PCS 7, 112
  SIMATIC PCS 7 BOX in the PCS 7 network, 32
  Single-station system, 26
  With external engineering, 29
  with SIMATIC PCS 7, 24

U
Update, 18, 145
  Hardware components of SIMATIC PCS 7 BOX, 18
  Software, 145
Usage of SIMATIC PCS 7 BOX, 11
Using AS RTX, 15

W
Write protection, 141